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About Thi

s User’s Manual

This manual provides detailed instructions on how to set up, use, manage, and maintain Atrust t68WD thin clients.

Manual Structure and Subjects

Chapter
1

2

3

Appendices

Specifications

Subject

Provides an overview of Atrust t68WD thin clients.
Provides detailed instructions on how to set up Atrust t68WD thin clients.
Provides the basics of how to use Atrust t68WD thin clients.

Provides instructions on how to configure client settings and customize Atrust t68WD thin clients
with the Atrust Client Setup console.

Provides supplementary instructions on the maintenance of Atrust t68WD thin clients.

Provides detailed information on key components of Atrust t68WD thin clients.

Notes, Tips, and Warnings

Throughout this manual, the notes, tips, and warnings in the following formats are used to provide important
information, useful advice, and prevent injuries to you, damage to your devices, or loss of data on your system.

=)) NOTE

« A note provides important information for a specific situation.

al

TIP

74

- Atip gives a piece of useful advice to perform a task more efficiently.

@ WARNING

- A warning provides crucial information that must be followed to prevent injuries to
you, damage to your devices, or loss of data on your system.



Style Conventions

The following styles are used throughout this manual while referring to operational items on input devices,
hardware panels, or application interfaces.

Item

keys on the keyboard

application windows or
entry lists

buttons or tabs on a
window, toolbars, taskbar,
or menu

options on a window,
screen, list, or menu

selecting a series of options

Style
bold

first letter

capitalized

bold

bold

bold

Example

ctrl + F2, Ctrl + Alt + F9, Alt + Tab

ICA Connection list, RDP Connection list, View Connection list

OK, Next, Save, Applications tab
Start the following program on connection, Remote Desktop
Services, Better Appearance (32-bit), Web Logon

Applications > Citrix ICA, Applications > Remote Desktop,
Applications > VMware View, System > UWF



Safety and Regulatory Information

Regulatory Statement

Federal Communications Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one of the following measures:

« Reorient or relocate the receiving antenna.
« Increase the separation between the equipment and receiver.
« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate this equipment. This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20 cm between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.



Regulatory Information

WEEE (Waste Electrical and Electronic Equipment) Directive
In the European Union, this symbol indicates that this product should not be disposed of with
household waste. It should be deposited at an appropriate facility to enable recovery and recycling. For
mmm  proper disposal, please contact your local recycling or hazardous waste center.

Safety Information

@ WARNING

+ Use only power supplies listed in the user instructions.

@ WARNING

« Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

@ WARNING

- For safety, do not make mechanical or electrical modifications to the equipment.

- Do not remove equipment covers and access any of the components inside the
equipment. Any access inside the equipment without an authorized or certified
technician may cause serious injuries and damage. For any problem, contact your
dealer for assistance.

+ You should only make repairs as authorized by the product documentation.
Repairs, replacement, expansion, and upgrades not performed by a certified service
technician may cause injuries to you, damage your system, and void your warranty.
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Overview

This chapter provides an overview of Atrust t68WD thin clients.

1.1 Introduction
Desktop virtualization and simple endpoint devices

1.2 Features
Key features of Atrust t68WD

1.3 Package Contents
Check your package contents

1.4 Exterior Views
Overview of thin client outside elements

1.5 Panel Components
Descriptions of front and rear panel components

1.6 LED Indicators
Descriptions of signals for LED indicators

1.7 Before Getting Started

About UWF (Unified Write Filter)
About the default user accounts
About the behavior of the system startup

1.8 Service Access with your t68WD
Standard and customized desktop shortcuts

o 0
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Introduction

1.1 Introduction

Desktop virtualization provides a new perspective to reconsider the design and implementation of an IT
infrastructure. In a desktop virtualization infrastructure, a station is no longer a cumbersome desktop, but simply
an endpoint device for users to access delivery services from the server(s).

With the introduction of the desktop virtualization technologies, you can considerably benefit from:

«  On-demand applications/desktops

« Centralized management of work environments

« Drastically reduced endpoint software/hardware issues

« Simplified system maintenance and Improved system security

« More scalability with low-cost endpoint devices

1.2 Features

The key features of Atrust t68WD thin clients are:

«  Support for a wide range of desktop virtualization solutions from industry-leading companies:
Microsoft® Remote Desktop
Citrix® XenApp™, XenDesktop®, and VDI-in-a-Box™
VMware® View™ and Horizon View™
«  Support for high-definition technologies:
Microsoft® RemoteFX®
Citrix® HDX™
VMware® View™ PColP®
- Simple click-access to various applications/desktops

«  Built-in Atrust Client Setup as the local client management console
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Package Contents

1.3 Package Contents

Please check your package contents. Ensure that all of the items are present in your package. If any items are
missing or damaged, please contact your dealer immediately.

Atrust t68WD AC adapter

Quick Start Guide

ALFUSE mocnstnon

Ce

VESA mount kit (Optional)

NOTE

(alll |

- Your package may not contain a hard copy of the Quick Start Guide. In this case, a
soft copy in PDF format will be provided.

1.4 Exterior Views

Left front view Right rear view

Front Panel Rear Panel Kensington
lock slot



1.5 Panel Components

Front Panel Components

Overview
Panel Components

No. Sign Name Description
1 Power LED Indicates the status of power.
5 0 Power button e Press to power on / off the thin client.

e Press to exit the System Sleep mode.

Microphone port

Connects to a microphone.

Headphone port

Connects to a set of headphones or a speaker system.

USB port

Connects to a USB device.

5
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Panel Components

Rear Panel Components

No. Sign Component Name Description
6 -—(c—+ DC IN Connects to an AC adaptor.

7 o> USB port (USB 2.0)  Connects to a USB device.

8 SS% USB port (USB 3.0) Connects to a USB device.

9 % LAN port Connects to a network.

10 i@ DisplayPort Connects to a monitor.

11 | | DVI-I port Connects to a monitor.
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LED Indicators

1.6 LED Indicators

Your t68WD is equipped with a Power LED to indicate the state of power. The meanings of LED signals are described
as follows:

LED Signal Meaning
Off The client is off.
Power LED Blue The client is on.
Orange The client is in System Sleep mode.

The LAN port of your t68WD is equipped with two LED indicators, showing the status of networking. The meanings
of LED signals of the LAN port are described as follows:

SPEED LED LINK/ACT LED
SPEED LED LINK/ACT LED .
(transmission rate) (linking/transmission activity) Meanlng
Off Off The client is not connected to a LAN.
Off Amber blinking The client connects to a 10 Mbps LAN.
LED Signal
Orange Amber blinking The client connects to a 100 Mbps LAN.

Green Amber blinking The client connects to a 1000 Mbps LAN.

7
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Before Getting Started

1.7 Before Getting Started
About UWF (Unified Write Filter)

Before getting started on client configuration through the Atrust Client Setup console or through the Windows
Embedded Standard operating system, please note that in a session any changes to the system will not be kept by

default after the system restart. This is due to a special feature called UWF (Unified Write Filter) in your Windows
Embedded-based system.

By default, your t68WD is UWF-enabled. Unified Write Filter (UWF) is a sector-based write filter intercepting all write
attempts to a protected volume and redirecting those write attempts to a virtual overlay. With UWF, all system
changes will only affect the session where the changes are made. After restart, all changes will be discarded.

You can change the default via the Atrust Client Setup console. It's strongly recommended that you read the related
section in this user’s manual first before making any changes to your system.

@ WARNING

« Please read the following section FIRST before making any changes to your system:
“4.2.10 Configuring UWF (Unified Write Filter)” on page 51.

=) NOTE

al

« As a thin client device, your t68WD is mainly for access to remote or virtual desktops
on servers. With the limited and protected (UWF-enabled) hard disk space, it's not
recommended to save data on your t68WD. Instead, you can use storage spaces
over remote / virtual desktops, removable storage devices, or networks.

« In case that you need to copy a file to the protected volume, ensure that its size is
smaller than the free memory (overlay) space. Otherwise, your system may have
unexpected results or become unresponsive.

About Default User Accounts

There are two default user accounts for your Windows Embedded-based system: one is the standard, the other
administrative. The default credentials are shown as follows:

Type Account Name Password

Administrator Administrator Atrustadmin

Standard user User Atrustuser
NOTE

(alll |

« The passwords are case sensitive.

About the Behavior of System Startup

Every time when the system is started up, it will automatically log in to the Windows Embedded operating system
using the default standard user account as indicated in the preceding table about default user accounts.
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Service Access with your t68WD

1.8 Service Access with your t68WD

With Atrust t68WD, you can simply access desktop virtualization solutions from Microsoft, Citrix, and VMware, by
mouse-clicking. Two types of access shortcuts are available: standard and customized. The former is available on
the desktop of Windows Embedded by default; the latter can be created and customized through the Atrust Client
Setup console.

Standard Desktop Shortcuts

You can find the instructions on how to use standard desktop shortcuts to access on-demand applications or
desktops in chapter 3 “Getting Started” on page 17 or in the Quick Start Guide for t68WD.

Customized Desktop Shortcuts

You can find the instructions on how to create and customize access shortcuts in chapter 4 “Configuring Client
Settings” on page 31.

9
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Setting Up Your t68WD

This chapter provides detailed instructions on how to set up your
t68WD thin client.

2.1 Positioning Your t68WD

To mount your t68WD

Step 1: Understand Your VESA Mount Kit for t68WD
Step 2: Mount Your t68WD

2.2 Assembling the AC Adapter
How to assemble the AC adapter and its detached plug

2.3 Getting Connected
How to connect peripherals and power for t68WD

13
14

15

15






Setting Up Your t68WD
Positioning Your t68WD

2.1 Positioning Your t68WD

There are two ways to position your t68WD:

« Putiton adesk oradesired place horizontally.

«  Mount it on the back of a monitor using a VESA mount kit.

NOTE

« The VESA mount kit is an optional accessory for your t68WD. Your package may not
contain a VESA mount kit. Contact your dealer if needed.

I

To mount your t68WD on the back of a monitor, please follow the steps below:

Step 1: Understand Your VESA Mount Kit for t68WD
Step 2: Mount Your t68WD

Step 1: Understand Your VESA Mount Kit for t68WD

Your t68WD's VESA mount kit consists of a bracket and six screws.

Mount bracket

Six screws with
two types

Mount Bracket

Refer to the following figure and descriptions for the VESA mount holes on the mount bracket for t68WD.

2 2
Mount Hole Description
1 The VESA mount holes used to secure the bracket to your t68WD.
2 The VESA mount holes (with the distance of 100 mm) used to secure the bracket to a monitor.

3 The VESA mount holes (with the distance of 75 mm) used to secure the bracket to a monitor.

13
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Positioning Your t68WD

w % P
%@%@ 2]

o ®

Screw Type Number Description
1 4 The screws used to secure the bracket to your t68WD and to a monitor.
5 2 The longer screws used to secure the bracket to a monitor if the screws of type 1
cannot firmly secure the bracket and your t68WD to the monitor.

Step 2: Mount Your t68WD

To mount your t68WD on the back of the monitor, please do the following:

1. Place your t68WD on a flat surface with the VESA mount hole side upward.

2. With the bracket side marked with Atrust facing downward, align two mount holes on the bracket with two
mount holes on your t68WD such that the bracket projects out and is closer to the rear panel than the front

one as shown below, and then secure the bracket to your t68WD with two (2) screws of type @J.

3. Align the mount holes on the bracket with the mount holes on the back of the monitor, and then secure the
bracket to the monitor with two (2) screws of0 or 9 Ensure that the rear panel of your t68WD
is facing downward as shown below.

Have t68WD's rear panel
facing downward.




Setting Up Your t68WD
Assembling the AC Adapter

2.2 Assembling the AC Adapter

To assemble the AC adapter for your t68WD, please do the following:

1. Unpack your thin client package and take out the AC adapter

and its detached plug.

v,
2. Slide the plug into the AC adapter until it clicks into place. ‘

%J NOTE

+ The supplied plug may vary, depending on different areas.

2.3 Getting Connected

To make connections for your t68WD, please do the following:

1. Connect your t68WD to your local network with an Ethernet cable.

2. Connect a keyboard and mouse to your t68WD.

3. Connect and turn on the monitor(s).

=)) NOTE
7

In case that only the VGA monitor is available, use the supplied DVI-I to VGA
adapter to connect your t68WD and monitor.

« Please note that you need to connect and turn on your monitor(s) before powering

up your thin client. Otherwise, the client may fail to set an appropriate resolution
for the monitor(s).

4. Connect your t68WD to a power outlet using the AC adapter included in the package.

%/ NOTE

For detailed instructions on how to assemble the supplied AC adapter, please refer
to section “2.2 Assembling the AC Adapter” on page 15.

5. Connect other peripherals for your t68WD if needed.

15
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Getting Started

This chapter provides the basics of how to use your t68WD.

3.1 Standard Shortcuts

Default shortcuts on the local (Windows Embedded
Standard) desktop

3.2 Accessing Citrix Services
How to access Citrix services

3.3 Accessing Microsoft Remote Desktop Services

How to access Microsoft Remote Desktop services

3.4 Accessing VMware View and Horizon View Services
How to access VMware View and Horizon View services

19

20

26

28
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Standard Shortcuts

3.1 Standard Shortcuts

You can access virtual desktop or application services simply through standard shortcuts available on the desktop.

No. Shortcuts Description See
Double click to access Citrix services.

NOTE: If the secure network connection is not implemented in your
Citrix environment, you might not be able to access Citrix

1 Chmr Resenves services through Citrix Receiver of this new version. Alternatively, =
Citrix allows service access simply through a Web browser. Try to
use the built-in Internet Explorer if you have problems with Citrix
Receiver (refer to instructions in this chapter).
Remote Desktop Connection Double click to access Microsoft Remote Desktop services. 3.3

VMware Horizon View Client Double click to access VMware View and VMware Horizon View services. 3.4



20| Getting Started

Accessing Citrix Services

3.2 Accessing Citrix Services

Accessing Citrix Service with Internet Explorer
To quickly access Citrix services with the Internet Explorer, please do the following:

1. Open the Internet Explorer by clicking its icon on the Start screen or the desktop taskbar.

2. Enter the IP address / URL / FQDN of the server through which Citrix services are accessible.

@ NOTE

« For XenDesktop 7.0 or the later, consult your IT administrator for the appropriate
IP address / URL / FQDN.

3. Follow the on-line instructions to provide the required data and access Citrix services.

Logon Screen Example
XenDesktop 5.6 Platinum

ginzs £ + B O | © CiricxenDesktop -Logon  x [

Citrix XenDesktop

Log on

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.
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Accessing Citrix Services

Virtual Desktop Example
Windows 7 Ultimate
(launched in t68WD)

t68WD Local Desktop
€l .

1404
/62015

Virtual Application Examples
Calculator, Firefox, Adobe Reader, and LINE
(launched in t68WD)

Fie Edt vew vindow Heb

Home  Tools
Q

|
| Q seren oot Log me n automatca

Run LINE when Windows starts.
D0 you ever wonder what companies do with the persona/
information they collect about you? Get Smart On Trackn|

‘ D Sign Up
» 2 | ==

6 () Export PDF Create PDF Edit PDF @ Forgotten your password?
Marketpiace  Add-ons

Open |+ Open |~

Fill & Sign Send for Signature Send & Track
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Accessing Citrix Services

Accessing Citrix Service through the Citrix Receiver Shortcut

To access Citrix services through the Citrix Receiver shortcut, please do the following:

1. Import the required safety certificate for available Citrix services with an administrator account. Consult your
IT administrator for necessary assistance.

a. On the desktop, move the mouse to the bottom-left corner, and then right click on the appeared

Start

. A popup menu appears as shown below.

Srams and Featun
Power Options
Event Viewer
System
Device Manager
Disk Management
Computer Management
Cemmand Prompt

Cemmand Prompt (Admin)

Task Manager
Control Panel
File Explorer

Search

Run

Desktop

b. Click to select Run on that popup menu.

¢. Enter mmc on the opened window, and then

@ Type the name of a program, folder, document, or Internet
press Enter. {

resource, and Windows will open it for you.

Open: | mmc v
d. Onthe Console WindOW, click the File menu ) This task will be created with administrative privileges.
to select Add/Remove Snap-in.

|| Cancel || Browse... |
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Accessing Citrix Services

File | Action View Favorites Window Help

- New Ctrl+N
IE| Open... a0 [ o =
Save Ctrl+5
Save As... There are no items to show in this view. _
More Actions.
| Add/Remove Snap-in.. Ctrle M
Options...
1 CAWindows\..Aeventvwr.msc File | Action View Faverites Window Help
= . New Ctrl+N
R Open... Ctrl+0
® Y Save Ctrl+5
Save As...
Add/Remove Snap-in... Ctrl+M
Options...

1 ChAWindowsh.. \eventvwr.msc

Exit

Enables you to add snap-ins o or remove them from the snap-in console.

e. On the opened window, click Certificates > Add > Computer account > Local computer > Finish >
OK to add the Certificates snap-in.

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled,

Available snap-ns: Selected snap-ns:

Snap-in vendor ~ [ console Root \M‘
=" Activex Control Microsoft Cor... e
EAuﬂmrizamn Manager Microsoft Cor,

ﬂ Microsoft Cor,

. Component Services  Microsaft Cor. Move Up
@Compuber Managem... Microsoft Cor.

Move Down

ﬂnevice Manager Microsoft Cor...
ﬁ Disk Management Microsoft and...
E Embedded Lockdow... Copyright {c) ...
gEvant Viewer Microsoft Cor...
[ IFolder Microsoft Cor.
Group Policy Object ... Microsoft Cor.
8, 1P Security Monitor  Microsaft Cor...

aIP Security Policy M... Microsoft Cor... W

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.
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Accessing Citrix Services

f.  On the Console window, click to expand the group tree of Certificates, right-click on Trusted Root
Certification Authorities, and then select All Tasks > Import on the popup menu.

T Object Type

e 2B o BE

[ Console Root
4 [ Certificates (Local Computer)
v [7] Personal

[T Certificates

1 [ Enterprise Trust

b [ Intermediate Certification Authr

b [] Trusted Publishers

b ] Untrusted Certificates 1

» ] Third-Party Root Certificati orrties
b [7] Trusted People

1 (] Client Authentication lss:

b [ Smart Card Trusted Roo'

b [ Trusted Devices

b [ Windows Live ID Toker

n Authon

1 [] Trusted Root Certification Authoriti |

Find Certificates...

N

More Adtions »

All Tasks

View
Mew Window from Here

Mew Taskpad View...

Refresh
Export List...

Help

Find Certificates...

Import...

Add a certificate to a store

g. Follow the Certificate Import Wizard to import your certificate, and then close the Console window

when it's done.

Store Location
() Current User

(®) Local Machine

To continue, dick Next.

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
conmections. A certificate store is the system area where certificates are kept.

Goce
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Accessing Citrix Services

2. Double click Citrix Receiver @ on the desktop.

3. A window appears prompting for the work email or server address. Consult your IT administrator for proper
information to provide here, enter the required data, and then click Add to continue.

Add Account

Enter your work email or server address provided

by your IT department:

4. Select the desired store account if more than one store is available, type credentials in the opened window,

and then click Log On.

Select account:

Add Account

Account

CTX
Store Service

Description

User name: I domain\user or user@domain.com

Password: I

[] Rermember my password

| Log On || Cancel

ﬂ Secure connection

25
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Accessing Microsoft Remote Desktop Services

5. A window appears allowing you to add favorite apps (virtual desktops and applications) for the provided
credentials. Click to select the desired application(s). The selected application(s) will appear on that window.

Citrix Receiver

Citrix Receiver

Al Applications

6. Now you can click to launch the desired application. The virtual desktop or application will be displayed
on the screen.

3.3 Accessing Microsoft Remote Desktop Services

To quickly access Remote Desktop services, please do the following:

1. Double click Remote Desktop Connection %:\ on the desktop.

2. Enter the name or IP address of the remote computer on the opened window, and then click Connect.

LT Remote Desktop Connection - ©

| Remote Desktop
) Connection

Computer: | Bxample: computer fabrikam com W

Username:  MNone specified

The computer name field is blank. Enter a full remote computer
name.

> Show Options Help
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Accessing Microsoft Remote Desktop Services

3. Enter your credentials, and then click OK.

Enter your credentials

These credentials will be used to cennect to 192.168.10.100,

“Jser name
I I ’ Password

Domain:

[ Remember my credentials

4. A window may appear with a certificate message about the remote computer. Consult your IT administrator
for details and ensure the connection is secure first. To bypass, click Yes to continue.

The remote computer could not be authenticated due to problems with its
securty certificate. it may be unsafe to proceed.

Certfficate name

@ Mame in the certificate from the remote computer:
WMS2011P

Certficate emors

The following emors were encountered while validating the remote
computer's certificate:

ﬁk The certificate is not from a trusted cerifving authority.

Do you wart to connect despite these cenfficate emors?
[] Don't ask me again for connections to this computer

View cerificate...

5. The remote desktop will be displayed on the screen (in full-screen by default).

27
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Accessing VMware View and Horizon View Services

3.4 Accessing VMware View and Horizon View Services

To quickly access VMware View or Horizon View services, please do the following:

1. Double click VMware Horizon View Client 'z~ " on the desktop.
2. A window appears allowing you to add the name or IP address of the View Connection Server.

3. Double-click Add Server icon or click New Server in the top-left corner.

+ Mew Server | || + newsener

Add Server

Add Server

4. A window appears prompting for the name or IP address of the View Connection Server. Enter the required
information, and then click Connect.

=
&

vmware Horizon

Enter the name of the Connection Server.

Connect

5. A window may appear with a certificate message about the remote server. Consult your IT administrator for
details and ensure the connection is secure first. To bypass, click Continue.

4 VMware Horizon Client cannot verify the identity of the server you
_,i have contacted. Your credentials will not be secure. Contact your
administrator to ask if this server can be trusted.

Show Certificate Continue | | Cancel

6. A window may appear with a Welcome message. Click OK to continue.
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Accessing VMware View and Horizon View Services

7. Provide your user name and password on the opened window, and then click Login.

=

vmware Horizon

|£h-i.=ha&:ﬁv'u'CS.VH'J.poc

|\.|’H'.I'

8. A window appears with available desktops or applications for your credentials. Double-click to select the
desired desktop or application.

w o e-

L] @

Mozilla Firefox

Adobe Reader XI

Snipping Tool Windows Media
Player

9. The desktop or application will be displayed on the screen.
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Configuring Client Settings

This chapter provides instructions on how to configure advanced
settings and customize your t68WD with Atrust Client Setup.

4.1 Atrust Client Setup
Interface overview
Available settings at a glance

4.2 Configuring System Settings

System tab overview
Available settings at a glance

4.3 Configuring External Device Settings
Devices tab overview
Available settings at a glance

4.4 Configuring User Interface Settings
User Interface tab overview
Available settings at a glance

4.5 Configuring Service Access Settings

Applications tab overview
Available settings at a glance
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59
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4.1 Atrust Client Setup

4.1.1 Interface Overview

To access Atrust Client Setup on your t68WD thin client, please do the following:

1. Log in to your t68WD with an administrator account (see page 8 for the default).

2. Click Atrust Client Setup on the Start screen.

3. The Atrust Client Setup window appears.

Atrust

» Remote Desktop

@00..0..0 ® » Citrix ICA

b VMware View

+ Web Browser

Interface Overview

O © 0 0

ecece
ecece
ecece
ecece

Applications | User Interface | Devices | System

| Remote Desktop Available Sessions: 0 LXY ]
i Configure RDP (Remote Desktop Protocol) connection settings

Citrix ICA Available Sessions: 0
Configure Citrix ICA connection settings

| VMware View Available Sessions: 0
W Configure VMware View connection settings

Web Browser Available Sessions: 0
Configure local browser settings

Interface Elements

No. Name

Description

1 System tab Click to configure settings for the operation and maintenance of the client.

2 Devices tab Click to configure settings for external devices of the client.

3 User Interface tab Click to configure the user interface of the client.

4 Applications tab Click to configure settings for service access through the client.

5 Navigation area Click to select a setting item under a selected tab or to select a setting entry under

a selected setting item.

6 Configuration area

Configures setting values when a setting item or entry is selected.

33
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4.1.2 Client Settings at a Glance

The following table provides a brief description of each setting item under four main setting categories.
Tab Setting Item Section Page

e Configuring passwords
e Configuring remote assistance settings
e Updating firmware . .
System ) 4.2 Configuring System Settings 35
e Taking snapshots for mass deployment
e Enabling/Disabling the Appliance mode

e Configuring UWF (Unified Write Filter) settings

e Configuring settings for USB storage devices

Devices T . ] ; 4.3 Configuring External Device Settings 53
e Configuring settings for audio devices
User Interface e Configuring the display of service access shortcuts 4.4 Configuring User Interface Settings 56
e Configuring Microsoft RDP connection settings
o e Configuring Citrix ICA connection settings . . . .
Applications 4.5 Configuring Service Access Settings 58

e Configuring VMware View connection settings
e Configuring Web browser session settings

NOTE

« The table above is only applicable to Atrust t68WD thin clients running Windows
Embedded 8 Standard. The available setting categories and items of the Atrust
Client Setup console for other Windows Embedded-based, Linux-based, and
ARM Linux-based thin clients might be different.

Lalll |
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4.2 Configuring System Settings

4.2.1 System Tab Overview

System tab enables you to configure settings for the operation and maintenance of clients. To access available
settings of System tab, click the tab on Atrust Client Setup.

.
System Tab Overview
Atrust Applications | User Interface | Devices | System
aoooooooco o+ Password
» Firmware Update Password " eee ececccce 9
Configure passwords for Atrust Client Setup and remote assistance
* Snapshot
» Appliance Mode t‘) Firmware Update
» UWE = Update firmware for this client

B snapshot
o Back up the current system state

Appliance Mode
Configure Appliance mode

UWF
Configure Unified Write Filter to protect your disk drives from unwanted changes

-

Interface Elements

No. Name Description

1 Navigation area Click to select a setting item under System tab.

2 Configuration area Configures setting values when a setting item is selected.
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4.2.2 Available Settings at a Glance

Tab Setting Icon

Password "

Firmware Ly
Update
Snapshot [s]
System f—

Appliance Ny
Mode

UWF ..‘

NOTE

(alll |

+ Atrust Device Manager is a remote and mass client management console, helping
you remotely mange a large number of endpoint devices in a desktop virtualization
infrastructure. For more information about Atrust Device Manager, please refer to

Description

Click to configure the access privileges of Atrust
Client Setup for client users.

Click to configure settings for remote assistance.

Click to update firmware locally with the help of
a remote management computer. This feature is
only applicable when the client is managed by
the Atrust Device Manager console.

Click to take a snapshot (system image) of the
client for mass deployment.

Click to enable/disable the Appliance mode to
allow/disallow the automatic RDP / ICA / View
sessions. In Appliance mode, the client starts up
with the desired RDP / ICA / View session and
shuts down when the user logs out.

Click to configure UWF (Unified Write Filter)
settings. Enabling UWF option will redirect all

writes targeted for disk volumes to a RAM cache.

All system changes will only affect the session
where the changes are made.

the User’s Manual for Atrust Device Manager.

Section

4.2.3

4.2.4

4.2.5

gD g g
N9 [
N

4.2.9

4.2.10

Page

37
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39

42
43
46

47

51
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4.2.3 Configuring the Access Privileges and Password of Atrust Client Setup
You can configure the access privileges of Atrust Client Setup for client users by the Password setting.

To set access privileges and password, please do the following:

%J’ NOTE

« System administrators (and only administrators) are allowed to access Atrust
Client Setup by default. If you don't set a password here, the administrator
privileges are sufficient to access Atrust Client Setup. If authentication is enabled

and the password is set, administrators will need that password to enter Atrust
Client Setup.

1. On Atrust Client Setup, click System > Password.

l\l:l'l.lsl: Applications User Interface Devices System

Navigator
enera
~ Password

» Firmware Update — Security

» -

Stapshiol [} O Require a password to access
+ Appliance Mode
Atrust Client Setup

» UWF

— Shadow

& Uenable shadow

|_save |[ cancal

2. Under the Security section, click to check Require a password to access Atrust Client Setup. A window
appears for you to set the password.

Set Password

Password: L ]

Confirm Password:

* Your password can contain letters, numbers, and special characters.

= It must be 4 to 20 characters long.

Save || Cancel

3. Type in the desired password, and then click Save to apply.
4. Click Save to store all the changes.
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4.2.4 Configuring Shadow Settings for Remote Assistance

The Shadow feature allows an administrator to remotely assist client users in resolving problems or configuring local

settings. When this feature is enabled, an administrator can monitor and control a client from a remote computer
just like a local user.

%J’ NOTE

« To use the Shadow feature on a remote computer, you need to install the Atrust
Device Manager and Java software on the remote computer (varied with your
version of Atrust Device Manager), and add your client into a managed group

under Atrust Device Manager. For detailed instructions, please refer to the
User’s Manual for Atrust Device Manager.

To enable the Shadow feature and set the password for remote assistance, please do the following:

1. On Atrust Client Setup, click System > Password.

Atrust

Applications User Interface Devices System

Navigator
enera

~ Password

» Firmware Update — Security

» -

Stapshiol [} O Require a password to access
+ Appliance Mode
Atrust Client Setup
» UWF

— Shadow

& Uenable shadow

[ sae || cancel

2. Under the Shadow section, click Enable Shadow.

3. The Shadow feature is enabled and a window appears for you to set the password for remote assistance.

Active Shadow Authorization

Password;

Confirm Password:

* Your password can contain letters, numbers, and special characters.

* It must be 1 to & characters lonag.

Save H Cancel
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NOTE

(alll |

- On aremote computer, an administrator will need this password to use the Shadow
feature (remote assistance) available in the Atrust Device Manager console. For
more information, please refer to the User’s Manual for Atrust Device Manager.

4. Type in the desired password, and then click Save to apply.

5. Click Save to store all the changes.

NOTE

W)

« When the Shadow feature is enabled, on t68WD, the icon will appear in the
Notification area of the Task bar. If this feature is currently being performed from a
remote computer, the icon will change its color to yellow E

4.2,5 Updating Firmware from the Management Computer

Update Firmware allows users to update client firmware from the remote management computer to get the
client device up-to-date.

NOTE

il

-+ Ensure that your client has been added into a managed group under Atrust Device
Manager installed on a remote computer, and that you have imported client
firmware files into Atrust Device Manager. These are prerequisites of this feature.

« For more information on firmware update and Atrust Device Manager, please refer
to the User’s Manual for Atrust Device Manager.

To update client firmware from the remote management computer, please do the following:

1. On Atrust Client Setup, click System > Firmware Update.
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Atrust

Applications | UserInterface | Devices | System
Navigat
enera
» Password
+ Firmware Update Firmware Update
» Snapshot
Current Version: WESS 1.37-INTL (t10W;t68WD;A200W)
+ Appliance Mode

Firmware Type:
r UWF

ALL

LMe

Check Firmware ‘

WARNING! This will remove all data you have placed on this machine.

* This setting will take effect after reboot.

Cancel

2. Under the Firmware Update section, click the Firmware Type drop-down menu to select Firmware. The
system will then automatically download the Firmware list from the remote computer.

@ NOTE

+ You can also update the firmware of a client with a snapshot (the system image of a
client) which is coming from another client of the same model and is with a newer

firmware version. For detailed information, please refer to sections about
the snapshot.

3. On completion, a window appears notifying you that the Firmware list has been loaded.
Click OK to continue.

@'/ NOTE

«+ The available firmware versions depend on how many versions have been imported
into the remote Atrust Device Manager.

4. Click drop-down menus to select the desired firmware version and other options.
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» Password

~ Firmware Update
» Snapshot

+ Appliance Mode

r UWF

[~ Firmware Update

Configuring Client Settings
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Applications | User Interface | Devices | System

General

Current Version: WESS 1.37-INTL (t10W;t68WD;A200W)

Firmware Type: [aLL e
Firmware Version: |WEBS 1.37-INTL ._
Language: |Dutch ~Me
Reboot immediately: [no e
Keep ACS configuration: |YES E‘h

Check Firmware

* WARNING! This will remove all data you have placed on this machine.

* This setting will take effect after reboot.

Update firmware Cancel

Firmware Update Options

Item

Description

Firmware Type

Click to select the desired firmware type.

Type Description

ALL All firmware types, Firmware and Snapshot.

Firmware The system image of a client.

Snapshot The system image of a client coming from another client of the same model.

Firmware Version

Click to select the desired firmware version from the Firmware list.

Language

Click to select the interface language of the system, including the Atrust Client
Setup console.

NOTE: Available languages may vary with the firmware version.

Reboot immediately

Click to choose whether to restart the system immediately for firmware update
or manually restart the system later.

Keep ACS configuration

Click to choose whether to keep client settings under Atrust Client Setup.

NOTE: If Yes is selected, all client settings under Atrust Client Setup will remain
unchanged after firmware update.
If No is selected, all settings will be restored to the factory default.

NOTE: If the client is managed by Atrust Device Manager and here No is
selected, Atrust Device Manager will fail to manage the client after
firmware update. For more information on Atrust Device Manager, please

refer to the User’s Manual for Atrust Device Manager.

5. Click Update firmware to confirm your selections. The system will start updating its firmware after restart.
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4.2.6 Taking Snapshots for Mass Deployment

A snapshot is the system image of a client, allowing you to use that image for mass deployment. This system image
can be stored on a remote management computer or a locally attached USB flash drive.

%J’ NOTE

- To store the system image on a remote computer, ensure that Atrust Device
Manager has been installed on that computer, and that the client has been added
into a managed group under Atrust Device Manager.

« When taking a snapshot, all system specific information, including the Computer
Security Identifier (SID) and computer name, will be reset or removed from the
system image by performing the System Preparation (Sysprep) tool automatically.

% NOTE

- Taking a snapshot will reset the startup behavior to the default (auto-login with the
default standard user account). For details, please refer to “About the Behavior of
System Startup” on page 8.

To take a snapshot from a client, please do the following:

1. On Atrust Client Setup, click System > Snapshot.

Atrust Applications User Interface Devices System
Navigat
Genera
+ Password
» Firmware Update Snapshot

~ Snapshot

Snapshot location: [Netwark ~Me
+ Appliance Mode

» UWE Snapshot description: "l

&

Snapshot type: ® Deployment ) Backup

* CAUTION! The system will reboot immediately for taking snapshot.

Apply Cancel

2. Under the Snapshot section, click the drop-down menu to select where to store the snapshot. Two options
are available: Network and USB.

- To store the snapshot file set on the remote computer, please select Network.

«+ To store the snapshot file set on the locally attached USB flash drive, please select USB.
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Type in the desired description for the snapshot.
Click to check Deployment as the snapshot type and then click Apply.

A message appears prompting for confirmation. Click Yes to confirm.

A

The system will restart to complete the process automatically.

5/ NOTE

« Please wait for the process to complete automatically. Taking a snapshot needs
several minutes and requires system reboot more than one time. In addition,

the Sysprep process will not be shown on the desktop but only be performed
in the background.

4.2.7 Deploying a System Image with a Created Snapshot

Your snapshots may be stored on a remote computer over the network or on a USB flash drive. Depending on where
your snapshot is located, you can deploy a system image either through a network or a USB flash drive.

5/ NOTE

- For detailed information on how to take a snapshot, please refer to section “4.2.6
Taking Snapshots for Mass Deployment” on page 42.

With a Snapshot on a Remote Computer

To deploy a system image on your t68WD with a snapshot on a remote computer, please do the following:

1. On Atrust Client Setup, click System > Firmware Update.

Atrust Applications User Interface Devices System
» Password
~ Firmware Update Firmware Update

+ Snapshot
napsho! Current Version: WESS 1.37-INTL (£10W;t58WD;A200W)

» Appliance Mode -
PP Firmware Type: ALL vle
¥ UWF

Check Firmware

* WARNING! This will remove all data you have placed on this machine.

* This setting will take effect after reboot.

Cancel
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2. Under the Firmware Update section, click the Firmware Type drop-down menu to select Snapshot. The
system will automatically download the Snapshot list from the remote computer.

3. Upon completion, a message appears notifying you that the Snapshot list has been loaded.

%J’ NOTE

- Client snapshots stored on the remote computer are managed by Atrust Device
Manager. For more information on how to manage client snapshots with Atrust
Device Manager, please refer to the User’s Manual for Atrust Device Manager.

4. Click OK to continue.

5. Click drop-down menus to select the desired snapshot and other options.

Atrust Applications User Interface Devices System

+ Password

~ Firmware Update — Firmware Update

13

Snapshot Current Version: WESS 1.37-INTL (E10W;t68WD;A200W)

» Appliance Mode -
Firmware Type: [Snapshot =

¥ UWF .
Firmware Version: [WESS 1.37INTL(Snapshot EK151118 e
Reboot immediately [no Me

| checkFimware |
* WARNING! This will remove all data you have placed on this machine.
* This setting will take effect after reboot.
Update firmware ‘ | Cancel
Options for Deploying a Snapshot
Item Description

Firmware Version Click to select the desired snapshot from the Snapshot list.

Reboot immediatel Click to choose whether to restart the system immediately for firmware update
Y or manually restart the system later.

6. Click Update firmware to confirm your selections. The system will start deploying the snapshot after restart.
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With a Snapshot on a USB Flash Drive
To deploy a system image on your t68WD with a snapshot on a USB flash drive, please do the following:

1.

o vk wN

Plug the USB flash drive into a free USB port of the client.

Start up or restart the client.

During the period of POST (Power-On Self-Test), press F7 to enter the Boot Device menu.
Select to boot from the attached USB flash drive.

The Atrust Thin Client Recovery System is launched.

Select USB, and then click Next to continue.

Atrust Thin Client Recovery System

Valid device: /dev/sdb1
USB mount successfully: device=/dev/sdb1

Please choose one source:

7. The recovery system start deploying the snapshot to the client.

8.

After completion, click Finish to restart the client.
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4.2.8 Taking Snapshots for System Backup

You can also take snapshots for thin clients to back up the systems. That system image can be stored on a remote
management computer or a locally attached USB flash drive.

To take a snapshot to back up the system for your thin client, please do the following:

1. On Atrust Client Setup, click System > Snapshot.

Atrust Applications User Interface Devices System

+ Password

+ Firmware Update Snapshot

~ Snapshot

Snapshot location [Network ~Me

» Appliance Mode
» UWF

Snapshot description: o ‘L

Snapshot type:  Deployment {® Backup

* CAUTION! The system will reboot immediately for taking snapshot.

Apply || cancel

2. Under the Snapshot section, click the drop-down menu to select where to store the snapshot. Two options
are available: Network and USB.

« To store the snapshot file set on the remote computer, please select Network.

« To store the snapshot file set on the locally attached USB flash drive, please select USB.
Type in the desired description for the snapshot.
Click to select Backup as the snapshot type, and then click Apply.

A message appears prompting for confirmation. Click Yes to confirm.

A

The system will restart to complete the process automatically.

%J’ NOTE

« Please wait for the process to complete automatically. Taking a snapshot needs
several minutes and requires system reboot more than one time.
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4.2,9 Enabling or Disabling the Appliance Mode

The Appliance mode allows your thin client to start up directly with the desired Microsoft Remote Desktop, Citrix
ICA, VMware View or Horizon View session. After existing a session, the client will be turned off.

—)) NOTE
W
« There are two similar but different modes for your thin client:

No. Mode Description

The client will start up directly with the desired
1 Appliance RDP / ICA / View session and turn off after
existing the session.

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after existing the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

« For more information on above modes, please refer to sections:

< 4.2.9 on page 47 (Appliance mode)

<> 4.5.5 on page 72 (Autostart mode for RDP sessions)

< 4.5.8 on page 100 (Autostart mode for ICA sessions)
<~ 4.5.11 on page 115 (Autostart mode for View sessions)

Enabling the Appliance Mode
To enable the Appliance mode, please do the following:

NOTE

« Ensure that you have configured the connection settings for the desired Microsoft
Remote Desktop, Citrix ICA, VMware View or Horizon View session under
Applications tab. You need to specify which service type and connection settings
entry will be used under the Appliance mode. For detailed instructions, please
see sections:

&)

< “4.5.3 Configuring Basic RDP Connection Settings” on page 60
< "4.5.6 Configuring Basic ICA Connection Settings”on page 85
< “4.5.9 Configuring Basic VMware View Connection Settings”on page 111
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1. On Atrust Client Setup, click System > Appliance Mode.

Atrust Applications User Interface Devices System
b Password
» Firmware Update Basic Settings
v -
Snapshot & Denable Appliance Mode
~ Appliance Mode

¥ UWF

| Save H Cancel

2. Click to check Enable Appliance Mode.
3. Other settings of the Appliance mode appear.

Basic Settings

; M Enable Appliance Mode

‘ Remote Deskiop e
[w7u vl

Application Type:

Use Session:

* To launch Console: Shift+Cirl+Delete
* To toggle RDP fullscreen: Cirl+Alt+Pause
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4. Click drop-down menus to select the application (or service) type: Citrix ICA, Remote Desktop, or
VMware View, and the specific service available in that type.

Basic Settings

E M Enable appliance Mode

| Remote Deskiop ~le

Application Type:
Use Session: ‘W;'U I;.

* To launch Console: Shift+Ctri+Delete

* To toggle RDP fullscreen: Ctri+Alt+Pause

Basic Settings

E M Enable appliance Mode

Application Type: § Citri ICA Ve
[x75P Ve

Use Session:

* To launch Console: Shift+Ctri+Delete

Basic Settings

& M Enable Appliance Mode

Application Type: { VMware View ~lE
[VMHE e

Use Session:

* To launch Console: Shift+Ctri+Delete

5. Click Save to confirm your selections.

6. The system will enter the Appliance mode after restart.

% ) NOTE
- To disable the Appliance mode or to access Atrust Client Setup under the Appliance
mode, please refer to “Disabling the Appliance Mode” on page 50.
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Disabling the Appliance Mode
To disable the Appliance mode, please do the following:

1. Under the Appliance mode, exit the Full Screen mode of the RDP / ICA session, or release the keyboard and
mouse from the View session (virtual desktop):

- To exit the Full Screen mode of the RDP session, press Ctrl + Alt + Pause.

« To exit the Full Screen mode of the ICA session, use the XenDesktop toolbar at the top
(You may not in the Full Screen mode).

« To release the keyboard and mouse from the View session (virtual desktop), press Ctrl + Alt.

NOTE

+ Please note that the View session (virtual desktop) will remain on the background
after you release the keyboard and mouse from the View session (virtual desktop).

i'/

2. Click Ctrl + Shift + Del to launch Atrust Client Setup.

NOTE

i)

+ You cannot access the Taskbar of the client operating system (Atrust ARM Linux)
under the Appliance mode.

3. On Atrust Client Setup, click System > Appliance Mode.
4. Click to uncheck Enable Appliance Mode, and then click Save to apply the change.
5. Return to the current RDP / ICA / View session:

+ To return to the current RDP / ICA session, use Alt + Tab (press and hold Alt, and then press Tab to switch
between different items) to select and restore the current RDP / ICA session.

« Toreturn to the current View session, click any place of the View session (virtual desktop)
on the background.

6. Log off from the current RDP / ICA / View session.

7. The client will shut down then. Restart your client manually.
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4.2.10 Configuring UWF (Unified Write Filter)

Your t68WD is UWF-enabled by default. Unified Write Filter (UWF) is a sector-based write filter intercepting all write
attempts to a protected volume and redirecting those write attempts to a RAM cache. With UWF, all system changes
will only affect the session where the changes are made. After restart, all changes will be discarded.

@ WARNING

« The UWF feature is enabled by factory default. Except for changes to ACS settings,
all the changes made in a session will not be kept after the system restart. Ensure
that you choose the desired settings here before making any changes to the system.

« Anicon in the Notification area of the Taskbar will indicate the current UWF state
of your system. For details, please refer to the description at the end of this section.

To configure the UWF settings, please do the following:

1. On Atrust Client Setup, click System > UWF.
2. Click the State drop-down menu to enable/disable the UWF feature.

Atrust

» Password

Applications | UserInterface | Devices | System

General

» Firmware Update UWF Setting
+ Snapshot

Next State: [Enabled Me
- UWF

Maximum used memory: (640 mB

&
[24 hours Me

When UWF is disabled, warn me every:

* This setting will take effect after reboot.

Save Cancel

3. Click to select other options if needed.

<’/ TIP
+ You can change the maximum memory size used only when UWF is disabled.
Disable UWF first, and then change the memory size used. A restart is required
when you switch the UWF state.
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UWF Options

Item Description
Next State Click to enable / disable UWF. A restart is required for switching.
Maximum used memory Click to select the maximum memory used for UWF.

When UWF is disabled, warn me every Click to select how often the system warns you when UWF is disabled.

4. Click Save to confirm your selections.

5. You may need to restart the system for the change(s) to take effect.

@ WARNING

+ You need to restart the system for switching between the UWF enabled and
disabled states. An icon will appear in the Notification area of the Taskbar to indicate
the current UWF state of the system. The following table provides a description of
eachicon:

Icon Name Description

The UWF is currently enabled. Except for

- f

= | Green Lock changes to ACS settl_ngs, all the oth'er ch_anges
made to the system in current session will not
be kept after the system restart.

The UWF state was changed and will take

Orange Lock effect after the system restart.

&

Red Lock The UWF is currently disabled.

TIP

+ When UWF is enabled, you can move the mouse pointer over the UWF icon to
check currently free memory (overlay) for UWF. A tooltip as below will be shown.

)

WVolume C: is protected by write filter
Overlay: 628 MB free of 640 MB

n 'Q'Fr'_;l i) £aU3 F i

6/10/2014

NOTE

- As a thin client device, your t68 WD is mainly for access to remote or virtual desktops
on servers. With the limited and protected (UWF-enabled) hard disk space, it's not
recommended to save data on your t68WD. Instead, you can use storage spaces
over remote / virtual desktops, removable storage devices, or networks.

[l

+ In case that you need to copy a file to the protected volume, ensure that its size is
smaller than the free memory (overlay) space. Otherwise, your system may have
unexpected results or become unresponsive.
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4.3 Configuring External Device Settings

4.3.1 Devices Tab Overview

Devices tab enables you to configure settings for external devices of clients. To access available settings of Devices
tab, click the tab on Atrust Client Setup.

Devices Tab Overview

Atrust Applications | User Interface | Devices | System
“00..0..00 o+ USB Storage
» Audio [y USB Storage eee ooooo-oog
Configure USB storage

@" Audio
Ml Configure audio device

Interface Elements

No. Name Description
1 Navigation area Click to select a setting item under Devices tab.
2 Configuration area Configures setting values when a setting item is selected.

4.3.2 Available Settings at a Glance

Tab Setting Icon Description Section Page

USB Storage 'LP Click to configure settings for USB storage devices. 4.3.3 54

Devices

Audio Q“' Click to configure settings for audio devices. 4.3.4 55
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4.3.3 Configuring Settings for USB Storage Devices

To configure settings for USB storage devices, please do the following:

1. On Atrust Client Setup, click Devices > USB Storage.

Atrust Applications User Interface

Devices System
~ USB Storage
+ Audio USE Storage
Security Options Enable USE Storage Ve

* This setting will take effect immediately. If you change this setting while a USB storage device is attached, the
change applies to the device only after it's replugged.

| Save Cancel

2. Click the drop-down menu to select the desired setting. Three options are available: Enable USB Storage,
Read-Only Access, and Disable USB Storage.

5/ NOTE

- When Enable USB Storage is selected, settings of RDP / ICA connection entries
under Applications tab may affect if you can use mapped USB storage devices in
remote / virtual desktop sessions. For details, please refer to sections:

< "4.5.5 Configuring Advanced RDP Connection Settings” on page 72
< "4.5.8 Configuring Advanced ICA Connection Settings” on page 100

« When Disable USB Storage is selected, Citrix ICA and VMware View / Horizon View
sessions may still allow users to use locally attached USB storage devices
through redirection. To really prevent the use of USB storage devices in virtual
desktop sessions, some configurations in Citrix and VMware service delivery
environments are required.

3. Click Save to store your change.
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4.3.4 Disabling or Enabling Attached Audio Devices

To disable/enable attached audio devices, please do the following:

%J NOTE

- If you disable locally attached audio devices, client users are not allowed to perform
audio playback or recording with these devices in an RDP / ICA / View session.

+ To perform audio playback or recording with local audio devices in an RDP / ICA /
View session, you need to enable locally attached audio devices here (the Audio
setting item under Devices tab) and configure audio related settings (if any) in the
RDP /1CA / View connection settings. For detailed instructions, please
refer to sections:

< “4.5.5 Configuring Advanced RDP Connection Settings” on page 72
< “4.5.8 Configuring Advanced ICA Connection Settings” on page 100
< “4.5.11 Configuring Advanced View Connection Settings”on page 115

1. On Atrust Client Setup, click Devices > Audio.

Atrust Applications | User Interface | Devices | System
—
» USB Storage
~ Audio Audio
& ¥ Enable System Audio Device
* This setting will take effect after reboot.

| Save H Cancel

2. Click to check/uncheck Enable System Audio Device.

3. Click Save to confirm your selection.

% NOTE

- The change will not take effect until the client has been restarted.
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4.4 Configuring User Interface Settings

4.4.1 User Interface Tab Overview

User Interface tab enables you to configure settings for the user interface of clients. To access available settings of
User Interface tab, click the tab on Atrust Client Setup.

User Interface Tab Overview

Atrust Applications | User Interface | Devices | System

“00..00.00 o+ Desktop

¢ Desktop

I . eee
Configure desktop icons

Interface Elements

No. Name Description
1 Navigation area Click to select a setting item under User Interface tab.
2 Configuration area Configures setting values when a setting item is selected.

4.4.2 Available Settings at a Glance

Tab Setting Icon Description Section Page

User Desktop rd Click to configure the display of standard

Interface (&1 desktop shortcuts for quick service access. D 57
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4.4.3 Configuring the Display of Standard Desktop Shortcuts for Quick Access

The Desktop setting enables you to display or hide the standard desktop shortcuts for service quick access. Three
standard desktop shortcuts are available: Citrix Receiver, Remote Desktop Connection, and VMware Horizon
View Client, separately for quick service access of Citrix XenApp / XenDesktop / VDI-in-a-Box, Microsoft Remote
Desktop / Remote Application (RemoteApp), and VMware View / VMware Horizon View.

x (C/ =

Remote Desktop Connection Citrix Receiver VMware Horizon View Client

TIP
%
+ You can use these standard desktop shortcuts to quickly access services.
For detailed instructions, please refer to chapter 3 “Getting Started” on page 17.

E/ NOTE

+ You can also customize your desktop shortcuts for quick service access. For detailed
instructions on how to create and customize your own desktop shortcuts, please
refer to section “4.5 Configuring Service Access Settings” on page 58.

To display or hide the standard desktop shortcuts for quick service access, please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

Atrust Applications User Interface Devices System
Genera

~ Desktop

Desktop Icons

& M Remote Desktop Connaction

& M citrix Receiver

& Mvmware view Client

Save Cancel

2. Click to check/uncheck Remote Desktop Connection, Citrix Receiver, or VMware View Client.

3. Click Save to apply.
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4.5 Configuring Service Access Settings

4.,5.1 Applications Tab Overview

Applications tab enables you to configure settings for service access on clients. To access available settings of
Applications tab, click the tab on Atrust Client Setup.

Applications Tab Overview

Atrust Applications | User Interface | Devices | System

o * Remote Desktop

¥ Citrix ICA | Remote Desktop Available Sessions: 0 " . . cele
o Configure RDP (Remote Desktop Protocol) connection settings
» VMware View
* Web Browser Citrix ICA Available Sessions: 0
Configure Citrix ICA connection settings

g vMware view Available Sessions: 0
Configure VMware View connection settings

,: i Web Browser Available Sessions: 0
Configure local browser settings

Interface Elements

No. Name Description

1 Navigation area

entry under a selected setting item.

Click to select a setting item under Applications tab or to select a setting

2 Configuration area

Configures setting values when a setting item or entry is selected.




4.,5.2 Available Settings at a Glance

Tab Setting Icon
Remote -l |

Desktop [eal

Citrix ICA @

Applications

VMware View

67

Web Browser

¢
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Configuring Service Access Settings

Description

Click to configure RDP (Remote Desktop Protocol)
connection settings and create access shortcuts
on the desktop for RDP sessions.

Click to configure Citrix ICA (Independent
Computing Architecture) connection settings and
create access shortcuts on the desktop for

ICA sessions.

Click to configure VMware View connection
settings and create access shortcuts on the
desktop for View sessions.

Click to configure browser session settings
and create access shortcuts on the desktop for
browser sessions.

Section

e B B
S @ i
N u b w

e
—o'°

4.5.12

Page

60

85

111

117



60| Configuring Client Settings

Configuring Service Access Settings

4.,5.3 Configuring Basic RDP Connection Settings

The Remote Desktop setting allows you to configure RDP (Remote Desktop Protocol) connection settings and
create shortcuts on the desktop or Start screen for Remote Desktop services. You can access services for work simply
through these shortcuts.

NOTE

« For more information on Microsoft Remote Desktop services, please visit Microsoft
website at www.microsoft.com.

(W)

Three connection types are available:

Connection Type Description Page
Remote Desktop Select to access remote desktops/applications. 61
Remote Web Access  Select to access remote desktops/applications through a Web browser. 63

Web Feed Select to access remote applications through published Start screen tiles. 65


www.microsoft.com
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Connection Type: Remote Desktop

To quickly configure RDP connection settings for Remote Desktop connection type, please do the following:
1.

On Atrust Client Setup, click Applications > Remote Desktop.

l\tl’LISI: Applications | User Interface Devices System
” + Add = Delete
~ Session Name
~ Remote Desktop
» Citrix TCA

Server Address

Connection Type
b VMware View
» Web Browser

O

2. The RDP Connection list appears in the Configuration area.

@ NOTE

- If you haven't create any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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Atrust Applications | User Interface Devices | System
Navigat 5
General |Options |RD Gateway
~ Remote Desktop
» Citrix ICA [~ Server Settings
b VMware View -
Session Name: “‘ |h
» Web Browser N
Server Address: “‘ |h_
Connection Type: ‘Remcle Desktop ElL
Connection Quality: [Very Fast (LAN) Ve
Server Authentication: [Connectand don'twam me Ve
[~ Login Settings
Username: [ &
Password: [ &
Domain: ‘ ||.
[~ Common Settings
Autostart When Startup: [No
On Application Exit: ‘ Do Nothing h_

Save H Cancel

4. On General sub-tab, type in the session name and the server/virtual machine address under the Server
Settings section.

@ NOTE

« The red asterisks indicate the required fields.

+ The remote computer can be a physical server or a virtual machine. Please visit
Microsoft’s websites at www.microsoft.com or support.microsoft.com for more
information.

5. Click Save to add this RDP connection entry.

6. The shortcut for Remote Desktop connection is automatically created on the desktop.

@ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.5.5 Configuring Advanced RDP Connection Settings” on page 72.


www.microsoft.com
support.microsoft.com
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Connection Type: Remote Web Access

To quickly configure RDP connection settings for Remote Web Access connection type, please do the following:

@ NOTE

+ Your t68WD supports only RD Web Access based on Windows Server 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, click Applications > Remote Desktop.

l\tl'LISI: Applications | User Interface Devices System
” + Add = Delete

~ Session Name
~ Remote Desktop

» Citrix TCA

Server Address
b VMware View

Connection Type
» Web Browser

O

2. The RDP Connection list appears in the Configuration area.

@ NOTE

- If you haven't create any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.

63



64

Configuring Client Settings
Configuring Service Access Settings

Atrust

~ Remote Desktop

Applications | User Interface Devices | System

General |Options |RD Gateway

¥ Citrix ICA
b VMware View

» Web Browser

[~ Server Settings

Session Name:
Connection URL:

Connection Type:

Remote Web Access o

— Common Settings
Autostart When Startup: [No Me
©On Application Exit: [Do Nothing Ve

Save H Cancel

4. On General sub-tab, click the Connection Type drop-down menu to select Remote Web Access.

5. Type in the session name and connection URL through which Web-based remote applications/desktops
is accessible.

@ NOTE

+ The red asterisks indicate the required fields.

« Consult your IT administrator for the appropriate connection URL.

6. Click Save to add this RDP connection entry.

7. The shortcut for Remote Web Access connection is automatically created on the desktop.

@ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.5.5 Configuring Advanced RDP Connection Settings” on page 72.
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Connection Type: Web Feed

To quickly configure RDP connection settings for Web Feed connection type, please do the following:

@ NOTE

+ Your t68WD supports only RD Web Access based on Windows Server 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, click Applications > Remote Desktop.

l\tl'LISI: Applications | User Interface Devices System
” + Add = Delete
~ Session Name
~ Remote Desktop
» Citrix TCA

Server Address

b VMware View

Connection Type
» Web Browser

O

2. The RDP Connection list appears in the Configuration area.

@ NOTE

- If you haven't create any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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Atrust Applications | User Interface Devices | System
Navigat 5
General |Options |RD Gateway
~ Remote Desktop
» Citrix ICA [~ Server Settings
b VMware View -
Session Name: “‘ |L
» Web Browser N
Web Feed URL: “‘ |L
Connection Type: tWeb Feed o

— Login Settings

Username: ’“‘

Passwaord: “‘

Domain: “‘

— RemoteApp and Desktop Connections

Update Now
Connection name:
Summary:

Last Update:

Save H Cancel

4. On General sub-tab, click the Connection Type drop-down menu to select Web Feed.

5. Type in the session name, the Web Feed URL through which remote applications is accessible, and your
credentials for Web Feed.

%J’ NOTE

+ The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate Web Feed URL.

6. Click Update Now in the RemoteApp and Desktop Connections section. After completion, the result will be
shown as blow in that section.

— RemoteApp and Desktop Connections

Update Mow

Connection name: Work Resources
Summary: 3 applications, 0 desktops
Last Update: Mon Aug 11 2014 18:47:51

7. Click Save to add this RDP connection entry.

8. The application tiles for Web Feed are automatically created on the Start screen.

3’/ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.5.5 Configuring Advanced RDP Connection Settings” on page 72.
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4.5.4 Accessing Remote Desktop Services

Connection Type: Remote Desktop
To access Remote Desktop services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

= NOTE
=i
+ You can also access Remote Desktop services through the standard desktop
shortcut Remote Desktop Connection. For detailed instructions on how to access

services via this standard shortcut, please refer to section “3.3 Accessing Microsoft
Remote Desktop Services” on page 26.

2. Follow the on-screen instructions and provide required credentials if needed.

3. The desired remote desktop will be displayed on the desktop in full screen (by default).

—1-) NOTE
5/
+ The connection type of Remote Desktop also allows you to launch application-

only sessions; only a specific application is launched rather than a full desktop. For

details, please refer to “4.5.5 Configuring Advanced RDP Connection Settings” on
page 72.

Example: Windows MultiPoint Server 2012

WMsU1 &
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Example: Windows Server 2012

=8 Windows Server 2012R2

Windows S

1932

[ I A5 gaans

Example: Windows 8 Enterprise

Trending
Mid o

One Month
& +109% 1l

5

New York City

Clear

20774

(M
1

=

a




Connection Type: Remote Web Access
To access remote applications/desktops, please do the following:

1. Double click the created shortcut on the desktop.

2. A window appears prompting for credentials.

Work Resources
RemoteApp and Desktop Connecion

Configuring Client Settings

Configuring Service Access Settings

Domaimusername: [
Passwor: [

Security(show explanation)
@®  Thisis a public or shared computer

O Thisis a private computer

To protect against unauthorized access, your RD Web
matically time out aftera pericd
ion ends, refresh your browser

‘@/ NOTE

« A warning message about security might appear. Consult your IT administrator
for details and ensure the connection is secure first. To by pass, click Continue to

this website.

« Click to select Allow to enable ActiveX Control when a popup message appears at

the bottom of the page.

3. Provide your credentials, and then click Sign in.
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4. Click to select RemoteApp and Desktops or Connect to a remote PC.

Work Resources
RemteApp and Desktop Comnection

Work Resources
RemeteApp snd Desktop Connection

Desktops

Enter the name of

Connect to:
s
e |

5. Clickicons or follow the on-screen instructions to launch applications or desktops.
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Connection Type: Web Feed
To access remote applications, please do the following:

1. On Start screen, click the application tile to launch an application.

Start

e B

Intemet Explorer | File Explorer

2. The application is opened on the desktop.

Adobe Reader
Fle Edit View Window Help

B FxeBe | 0 1 Tools | Sign | Comment

v Export PDF.

Adobe ExportPDF
Convert PDF il to Word or Excel
onine.

Select POF File:

Open a Recent File Adobe Online Services

B9 My Computer.. ,%] Convert PDF to Word or Excel
4

2 coneros

B3 Adobat.com

@ Mosila Firefox tart Page.

e Tool: Help

DS

Sign in

e
pre—
“Eeoa
i

£ Sign in with Facebook

G,
>y
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4,5.,5 Configuring Advanced RDP Connection Settings

The table below provides a description of each setting item for RDP connections. Please see this table to configure
advanced settings and customize your t68WD desktop shortcuts or Start screen tiles for service access.

NOTE

(]

« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Remote Desktop

%/ NOTE

- For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 79.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 81.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Desktop sessions.
Type in the computer name or IP address of the server/virtual machine where to
Sever Address deliver a Remote Desktop session.
This table only provides descriptions for available settings when
Remote Desktop is selected.
Three connection types are available:
Option Description
Connection Type Remote Desktop Provides access to remote desktops/applications.

Provides access to remote desktops/applications
Remote Web Access through a Web browser (Internet Explorer).

Provides access to remote applications through
Web Feed published Start screen tiles.

Select the setting that best describes the quality of your network connection.

Three options are available: Very Fast (LAN), Fast (Broadband), and
Slow (Modem).

Connection Quality
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Server Authentication

Select what to do next if the client cannot verify the identity of the remote
computer. Three options are available: Connect and don’t warn me,
Warn me, and Do not connect.

Option Description

Connect and don't Connects anyway without any warning.

warn me
Warns and allows users to choose whether t
Warn me a and allo o choo (o]
connect or not.
Do not connect Disallows the connection.

Login Settings

Item Description

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Type in the domain of the server.

Domain

NOTE: Leave this field blank if the server doesn’t belong to any domain.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Remote Desktop session automatically or not when
Windows Embedded starts.

If Yes is selected, every time when you log in to the system, the Remote
Desktop session will be opened automatically.

On Application Exit

Select what to do when a Remote Desktop session is ended. Four options are
available: Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Remote Desktop session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Options Sub-tab

Programs

Item

Description

Start the following program
on connection

Click the drop-down menu to enable/disable the Application mode. You can use
this option to select the session type. Two remote session types are available:

e Remote Desktop (when the Application mode is disabled)
e Remote Application (when the Application mode is enabled)

NOTE: Remote Application sessions are Remote sessions used to access only
specific applications rather than full desktops.

NOTE: Before you can open a Remote Application session, you need to add the
desired application to the RemoteApp Programs list with RemoteApp
Manager on the application hosted server. For detailed instructions on
how to add a desired application to the RemoteApp Programs list on the
server, please visit Microsoft Support website at support.microsoft.com.

Start in the following folder

Type in the location of the desired application (on the host server) if
Start the following program on connection is enabled.

NOTE: You can type in the location/path of the desired application in this field,
and specify only the name of the application in Program path and file
name (the next field). Or, you can type in the full path and name of the
application in Program path and file name, and leave this field empty.

Program path and file name

Type in the path and name of the desired application if Start the following
program on connection is enabled.

Remote APP Format Example

Windows Media Player C:\Programs Files (x86)\Windows Media Player\wmplayer.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32

NOTE: the file extension can be omitted.

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Four options are available: 15 Bit, 16 Bit, 24 Bit, and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: You can configure the upper limit of the color depth for a Remote Desktop
session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.

Resolution

Click the drop-down menu to select the desired display resolution on a Remote
Desktop session. Twelve options are available: Fullscreen, 1920x1200,
1920x1080, 1680x1050, 1400x1050, 1440x900, 1280x1024, 1280x768,
1280x720, 1024x768, 800x600, and 640x480.
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Multi-Monitor

Click the drop-down menu to enable/disable multiple displays in a Remote
Desktop session.

Display the connection bar
when I use the full screen

Click the drop-down menu to select if the Connection bar is displayed or not in
full-screen mode.

Connection Settings

Item

Description

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add the desired local or network printer(s) for your thin
client first, and then enable this feature here to use that printer in a
Remote Desktop session.

NOTE: To add a local or network printer for your Windows Embedded-based thin
client, go to Control Panel, click Hardware and Sound > Devices and
Printers > Add a printer, and then follow the on-screen instructions to
add the desired local or network printer.

Clipboard Redirection

Click the drop-down menu to enable/disable Clipboard redirection.

NOTE: When Enable is selected, Clipboard can be used across local and remote
desktops (in both directions).

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in @ Remote Desktop session.

Port Mapping

Click the drop-down menu to enable/disable port mapping.

When Enable is selected, users can access attached devices using locally
available ports, in a Remote Desktop session.

NOTE: The types and availability of device ports on thin clients may vary,
depending on your product models.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the computer sounds and audio playback
setting in a Remote Desktop session. Three options are available: Bring to this
computer, Do not play, and Leave at remote computer.

Option Description

Allows computer sounds and audio playback in a
Remote Desktop session using locally attached
audio devices.

Bring to this computer

Disables computer sounds and audio playback

Do not play in a Remote Desktop session.

Leave computer sounds and audio playback at

Leave at remote computer the remote computer.
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Remote Audio Recording

Click the drop-down menu to configure the audio recording setting in a Remote
Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description

Allows audio recording in a Remote Desktop

Recording from this computer session using locally attached audio devices.

Disables audio recording in a Remote Desktop

Do not record session using locally attached audio devices.

NOTE: When Leave at remote computer is selected on the drop-down menu
of Remote Audio Playback, this setting item will be grayed out.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On this computer, On the remote computer,
Only when using the full screen.

Drives

Click the drop-down menu to enable/disable locally attached drives in a Remote
Desktop session.

Supported plug and play
devices

Click the drop-down menu to enable/disable the supported plug and play devices
in @ Remote Desktop session.
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RemoteFX USB redirection

Click to enable/disable locally attached RemoteFX USB devices.

NOTE: To use RemoteFX USB devices in remote desktops, you need to configure
the policy setting about device redirection to allow RemoteFX USB Device
Redirection as well. To do so, please follow the steps below:

1. Log in to your t68WD with an administrative account.

2. Disable UWF (Unified Write Filter) through Atrust Client Setup
(See “4.2.10 Configuring UWF (Unified Write Filter)” on page 51).

3. On the desktop or Start screen, move your mouse to the bottom-right
corner. The charms appear.

4. Click Search to select the Search charm.

5. Type group policy in the Search charm, and then click Settings.
Edit group policy appears on the left.

Click to select Edit group policy. carch

Settings

. Group Policy
Settings

Apps
Fo) Settings

7. On the opened window, select Computer Configuration >
Administrative Templates > Windows Components > Remote
Desktop Services > Remote Desktop Connection Client >
RemoteFX USB Device Redirection > Allow RDP redirection of
other supported RemoteFX USB devices from this computer.

8. Select Enabled and to which users this setting applies: Administrators
Only or Administrators and Users, and then click OK.

9. Enable UWF through Atrust Client Setup.
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RD Gateway Sub-tab

Connection Settings

Item Description

Click the drop-down menu to choose if a RD Gateway server is used,
automatically detected, or manually configured. Three options are available:
Automatically detect RD Gateway server settings, Use these RD Gateway
server settings, and Do not use an RD Gateway server.

RD Gateway Server Settings

Type the IP address / URL / FQDN of the RD Gateway server.

Sever Name
NOTE: Consult your network administrator for details.

Click the drop-down menu to select the logon method. Three options
are available: Allow me to select later, Ask for password (NTLM), and
Smart card.

Option Description
Users can select a logon method while
Logon method Allow me to select later connecting to the server.

Users will be prompted for a password while

Ask for password (NTLM) connecting to the server.

Users will be prompted for a smart card

Smart card while connecting to the server.

Bypass RD Gateway server for Check to prevent traffic to and from local network addresses from being routed
local addresses through the RD Gateway server and make a connection faster.

Logon Settings

Item Description

Use my RD Gateway credentials | Check to use the same set of credentials for authenticating to both the RD
for the remote computer Gateway server and the remote computer.
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Settings for the Connection Type of Remote Web Access

=) NOTE

al

General Sub-tab

- For descriptions of settings for the connection type of Remote Desktop, please
refer to “Settings for the Connection Type of Remote Desktop” on page 72.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 81.

Server Settings

Item

Description

Session Name

Type in the name for Remote Web Access sessions.

Connection URL

Type in the connection URL through which RD Web Access is available.

Connection Type

This table only provides descriptions for available settings when Remote
Web Access is selected.

Three connection types are available:

Option Description

Remote Desktop Provides access to remote desktops/applications.

Provides access to remote desktops/applications

Remote Web Access through a Web browser (Internet Explorer).

Provides access to remote applications through

Web Feed published Start screen tiles.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Remote Desktop session automatically or not when
Windows Embedded starts.

If Yes is selected, every time when you log in to the system, the Remote
Desktop session will be opened automatically.

On Application Exit

Select what to do when a Remote Desktop session is ended. Four options are
available: Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Remote Desktop session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Options Sub-tab

NOTE

i)

- No options are available under the Options sub-tab in the connection type of
Remote Web Access.

RD Gateway Sub-tab

NOTE

(i)

- No options are available under the RD Gateway sub-tab in the connection type of
Remote Web Access.
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Settings for the Connection Type of Web Feed

=) NOTE

al

- For descriptions of settings for the connection type of Remote Desktop, please
refer to “Settings for the Connection Type of Remote Desktop” on page 72.

- For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 79.

General Sub-tab

Server Settings

Item Description

Session Name

Type in the name for Web Feed sessions.

Web Feed URL

Type in the URL through which RD Web Feed is accessible.

This table only provides descriptions for available settings when Web Feed
is selected.

Three connection types are available:

Option Description

Connection Type Remote Desktop Provides access to remote desktops/applications.

Provides access to remote desktops/applications

Remote Web Access through a Web browser (Internet Explorer).

Provides access to remote applications through

Web Feed published Start screen tiles.

Login Settings

Item Description

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Type in the domain of the server.

Domain

NOTE: Leave this field blank if the server doesn’t belong to any domain.

RemoteApp and Desktop Connection

Item

Description

Update Now

Click to fetch and update the published applications list from the server.
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Options Sub-tab

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Four options are available: 15 Bit, 16 Bit, 24 Bit, and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: You can configure the upper limit of the color depth for a Remote Desktop
session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.

Resolution

Click the drop-down menu to select the desired display resolution on a Remote
Desktop session. Twelve options are available: Fullscreen, 1920x1200,
1920x1080, 1680x1050, 1400x1050, 1440x900, 1280x1024, 1280x768,
1280x720, 1024x768, 800x600, and 640x480.

Multi-Monitor

Click the drop-down menu to enable/disable multiple displays in a Remote
Desktop session.

Display the connection bar
when I use the full screen

Click the drop-down menu to select if the Connection bar is displayed or not in
full-screen mode.

Local Resources Settings

Item

Description

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On this computer, On the remote computer,
Only when using the full screen.
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RemoteFX USB redirection

Click to enable/disable locally attached RemoteFX USB devices.

NOTE: To use RemoteFX USB devices in remote desktops, you need to configure
the policy setting about device redirection to allow RemoteFX USB Device
Redirection as well. To do so, please follow the steps below:

1. Log in to your t68WD with an administrative account.

2. Disable UWF (Unified Write Filter) through Atrust Client Setup
(See “4.2.10 Configuring UWF (Unified Write Filter)” on page 51).

3. On the desktop or Start screen, move your mouse to the bottom-right
corner. The charms appear.

4. Click Search to select the Search charm.

5. Type group policy in the Search charm, and then click Settings.
Edit group policy appears on the left.

Click to select Edit group policy. carch

Settings

. Group Policy
Settings

Apps
Fo) Settings

7. On the opened window, select Computer Configuration >
Administrative Templates > Windows Components > Remote
Desktop Services > Remote Desktop Connection Client >
RemoteFX USB Device Redirection > Allow RDP redirection of
other supported RemoteFX USB devices from this computer.

8. Select Enabled and to which users this setting applies: Administrators
Only or Administrators and Users, and then click OK.

9. Enable UWF through Atrust Client Setup.
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RD Gateway Sub-tab

NOTE

i)

- No options are available under the RD Gateway sub-tab in the connection type of
Remote Web Access.
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4,5.6 Configuring Basic ICA Connection Settings

The Citrix ICA setting allows you to configure ICA connections for Citrix services and create shortcuts on the local
desktop for service access. You can access virtual desktops and applications for work simply through these shortcuts.

%J’ NOTE

+ For more information on Citrix desktop virtualization solutions, please visit Citrix
website at www.citrix.com or Citrix Knowledge Center at support.citrix.com.

%J NOTE

+ You can also access Citrix services through the Internet Explorer or the standard
desktop shortcut Citrix Receiver. For detailed instructions on how to access
services via this standard desktop shortcut, please refer to section “3.2 Accessing
Citrix Services” on page 20.

«+ The following topics in this section will guide you through the steps of creating and
customizing your own service access shortcuts on the desktop and Start menu.

- To configure connection settings for Citrix VDI-in-a-Box, you can choose Web
Logon or XenDesktop connection type.

Connection Type: Web Logon
To quickly configure ICA connection settings for the connection type of Web Logon, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust Applications User Interface Devices System

: + Add = Delete
Navigator 5
ession Name Server Address Connection Type

» Remote Desktop
> Citrix ICA

b VMware View
* Web Browser

[0
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@'/ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, leave the connection type as Web Logon as default, and then type in the desired
session name and the IP address / URL / FQDN of the server through which Citrix services are accessible
under the Server Settings section.

l\l:l'ust Applications | User Interface Devices System
S —
* Remote Deskiop
* Citrix ICA — Server Settings
VM Vi N
ware View Session Name: “‘ ‘h
» Web Browser )
Connection Type: ‘Web Lagon Eh
Server Address: X‘ ‘L‘

— Common Settings

Autostart When Startup: ‘ No Eh‘

on Application Exit: [Do nothing Ve

Save || Cancel

@ NOTE

 The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

5. Click Save to add this ICA connection entry. The access shortcut will be created automatically on the desktop.

@ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 100.
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Connection Type: XenDesktop
To quickly configure ICA connection settings for the connection type of XenDesktop, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust

Applications | User Interface | Devices | System

; + Add = Delete

~ Session Name

» Remote Desktop
> Citrix ICA

Server Address Connection Type

b VMware View

} Web Browser

o

@ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, click the Connection Type drop-down menu to select XenDesktop.
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Atrust Applications | User Interface Devices System
Navigator E——
S—
* Remote Deskiop
* Citrix ICA — Server Settings
» VMware View -
Session Name: 8 &
» Web Browser R
Connection Type: {XenDeskiop ivlg
Server Address: “‘ ‘L
Username: X‘ ‘L‘
Password: Bl &
Domain: X‘ ‘h‘
Desktop Group: R X‘ ‘;
— Common Settings
Autostart When Startup: ‘ No Eh‘
On Application Exit: ‘ Do nothing h‘

Save || Cancel

5. Type the session name, the IP address / FQDN of the server through which XenDesktop is accessible,

user credentials, the domain of the server, and then click the Search icon ﬂ) to discover available
desktop groups.

% NOTE

- The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

« The Search icon works only when required data (fields marked with a red asterisk)
have been provided.

6. Upon completion, the Search Dialog window appears for you to select the desktop group. Click the
drop-down menu to select the desired desktop group, and then click Select to confirm.

Search dialog _‘

Desktop Group :

WUS Deskiops E|
)

Select || Cancel

7. The selected desktop group name automatically appears in the Desktop Group field.

8. Click Save to confirm. The access shortcut will be created automatically on the desktop.

%J‘ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 100.
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Connection Type: XenApp
To quickly configure ICA connection settings for the connection type of XenApp, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust

Applications | User Interface | Devices | System

; + Add = Delete

~ Session Name

» Remote Desktop
> Citrix ICA

Server Address Connection Type

b VMware View

} Web Browser

o

@ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, click the Connection Type drop-down menu to select XenApp.
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Atrust Applications User Interface Devices System
Navigator E——
General | Application
* Remote Deskiop
* Citrix ICA — Server Settings
» VMware View -
Session Name: “‘ ‘h
» Web Browser N
Connection Type: {XenApp Ve
Server Address: “‘ ‘L
Username: X‘ ‘;
Password: “‘ ‘;
Domain: X‘ ‘h‘
Application Name: el = &
— Common Settings
Autostart When Startup: ‘ No Eh‘
on Application Exit: ‘ Do nothing 4]

Save || Cancel

5. Type the session name, the IP address / FQDN of the server through which XenApp is accessible, user
credentials, the domain of the server, and then click the Search icon to discover available applications.

% NOTE

- The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

« The Search icon works only when required data (fields marked with a red asterisk)
have been provided. If your XenApp server doesn’t belong to any domain, just type
its computer name in the Domain field.

6. Upon completion, the Search Dialog window appears for you to select the application. Click the drop-down
menu to select the desired application, and then click Select to confirm.

Search dialog

Application Name :
EPDF Reader X

Select || Cancel |

7. The selected application name automatically appears in the Application Name field.

8. Click Save to confirm. The access shortcut will be created automatically on the desktop.

%J‘ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 100.
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Connection Type: Server Connection
To quickly configure ICA connection settings for the connection type of Server Connection, please do the following

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust

Applications | User Interface | Devices | System

; + Add = Delete

~ Session Name

» Remote Desktop
> Citrix ICA

Server Address Connection Type

b VMware View

} Web Browser

o

@ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, click the Connection Type drop-down menu to select Server Connection.
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Atrust Applications | User Interface Devices System
General Appicahon

* Remote Deskiop

* Citrix ICA — Server Settings

FEMHI RS Ml Session Name: “‘

» Web Browser

Connection Type: {Server Conneclion ivle

Server Address: 3

Username: X‘

Password: “‘

Domain: X‘

— Common Settings

Autostart When Startup: [No Me
On Application Exit: ‘ Do nothing Eh‘
Save | | Cancel

5. Type the session name, the IP address / FQDN of the server, user credentials, and the domain of the server.

@ NOTE

« The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

+ Only connections to XenApp servers are supported by this connection type.

6. Click Save to confirm. The access shortcut will be created automatically on the desktop.

@'/ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 100.
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4.,5.7 Accessing Citrix Services

For Connection Types of XenDesktop, XenApp, and Server Connection
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

@ NOTE

- You can also access Citrix services through the standard desktop shortcut Citrix
Receiver. For details on how to access services via the standard desktop shortcut,
please refer to section “3.2 Accessing Citrix Services” on page 20.

2. The desired application or desktop is displayed on the screen.

For Connection Types of Web Logon
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

@ NOTE

+ You can also access Citrix services through the standard desktop shortcut
Citrix Receiver. For details on how to access services via the standard desktop
shortcut, please refer to section “3.2 Accessing Citrix Services” on page 20.

2. The Web browser is launched with the Citrix Logon screen.

Logon Screen Example: XenApp 6.5 Platinum

LY ) © nitp:/xa6Sp coxpac/Citrix/XenApp/auth/login.aspx P~ B0 || @ Citrix XenApp - Logon x !

e
e CITRIX

Citrix XenApp

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.
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Logon Screen Example: XenDesktop 5.6 Platinum

L3P © hitp://ddexd5bp.cix poc/Citrix/ DesktopWeb/auth/login.es O = B & || @ citri XenDesktop - Logon

Citrix XenDesktop

Log on

User name:
. Password:
. € =,

Domain:

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

Logon Screen Example: XenApp and XenDesktop 7.5 Platinum

CENED) B hti://xa75p.ctepoc Citrix/Storeleb,

CitrixReceiver
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3. Type in the required credentials and domain name, and then click Log On.

‘ ) NOTE

- If your service-hosted server doesn’t belong to any domain, type in the server name
instead if required.

4. Click to select the desired application(s) or desktop(s).

Screen for On-Demand Applications: XenApp 6.5 Platinum

RSB O hitp://192.168.0.11/Citrix/XenApp/site/defaultaspr 2 ~ B & || @ Citrix XenApp - Applications fr K 18
3 & . ’
Search .
2 E  Logged onas:crxuz Messages Settings Log OFf ~ CITRIX

@

Motepad PDF reader PPT viewer

Hint Click Reconnect to resume any pausad resources.
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Screen for On-Demand Desktops: XenDesktop 5.6 Platinum

&~ @\@ hitp://192.168.0.5/Citrx/DesktopWeb/ste/directLaunch. O = B & || @ Citrx XenDesktop | ‘ X

Screen for On-Demand Applications: XenApp 7.5 Platinum

Citrix Receiver
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Screen for On-Demand Desktops: XenDesktop 7.5 Platinum

CitrixReceiver

5. The selected application(s) or desktop(s) will be displayed on the screen.

Example: Desktop Delivered by XenDesktop 5.6 Platinum
Windows 7 Ultimate

Welcome to your Citrix XenDesktop.

Any Device

Access is easy from any PC,
Mac, smartphone or tablet
The choice s yours.

Welcome to the virtual workstyle

High Definition

Blazing speed and stunning
graphics over any network,
er - powered by Citrix XenDesklop. including Wi-Fi or 3G.

Your desktop, apps and documents at your fingertips

o [ cee |

N D)
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Example: Desktop Delivered by XenDesktop 7.5 Platinum
Windows Server 2008 R2

Example: Applications Delivered by XenApp 6.5 Platinum
PowerPoint Viewer, Adobe Reader, and Skype

a
o )| @ hitp//xa65p ceepocyCi site/defaultaspx £ - 20| @ ciixxenrpp - Applcations x| | @ @

Window_Help

e BB EGEEE]0

Adobe ExportPDF
Convert PDF files to Word or Excel
online

Select PDF File:

Open a Recent File Adobe Online Services
B W Computer.. A, ComenTe

B3 Adobatcom
@ Creste POF

G2 sendand Trck s onlne ST

@ Get Documents Signed

-l 0 =@
|| Date modified || Type I=l
No ftems match your search.

ssssss

o | >
-
Files of type: | PowerPoint Presentations - Cancel J)
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Example: Applications Delivered by XenApp 7.5 Platinum
PowerPoint Viewer, Adobe Reader, and Mozilla Firefox

8 o7

cbupocCitrx/StoreWeb o-cl@

Citrix Receiver
B8 Adobe Reader

(===
Fie Edt View Window Help

= Documents &3 F) [ B e 0 ] " Tools | Sign | Comment

v Export PDF

‘Adobe ExportPDF

Convert PDF files to Word or Excel
oniine.

Select POF File:

Open a Recent File

B My Computer.

L Microsoft Office PowerPoint Viewer
Looki: (5 Documerts - e @

Name = Date modified  Type

Notems match your search.

Google Search

more sbout
d our global Maker

¥ ® O

e e T Dounloads  Bookmarks

Flesoftpe: [PowerPom Presentaions )

Choose WhatIShare | x
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4,5.8 Configuring Advanced ICA Connection Settings

The table below provides a description of each setting item for ICA connections. Please refer to this table to
configure advanced settings and customize shortcuts on the desktop and Start menu for service access.

NOTE

(]

- Please note that available settings vary depending on the selected connection type.

Settings for the Connection Type of Web Logon
=)) NOTE

- For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 102.

- For descriptions of available settings for the connection type of XenApp, please refer
to “Settings for the Connection Type of XenApp” on page 105.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 108.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when Web Logon
is selected.

Four connection types are available:

Option Description

Provides application, desktop, and content
Web Logon access services through the interface of a
Web browser (Internet Explorer).

. XenDesktop Provides desktop delivery services.
Connection Type
XenApp Provides application delivery services.
. Provides full server access services for
Server Connection

administrators (XenApp servers only).

NOTE: When Web Logon is selected, your t68WD will use a Web browser for
service access. The Internet Explorer is always used no matter if you
have installed other browsers and which browser you have set as default.

For more details, please refer to section “4.5.7 Accessing Citrix Services”
on page 93.

Sever Address Type in the_ IP address / URL / FQDN of the server through which Citrix services
are accessible.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Web Settings
Item Description

Mode Setting

Click the drop-down menu to select the desired browser window mode. Two
options are available: Full Screen and Normal Mode.

Option Description
Full Screen The browser is opened in the Full Screen mode.
Normal Mode The browser is opened in the Normal mode.

NOTE: This setting item is available only when Web Logon is selected in the
Connection Type field. This type of connection allows you to access
services through the interface of the Web browser.

NOTE: The used Web browser for service access is always the Internet Explorer,
no matter which browser you set as the default.
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Settings for the Connection Type of XenDesktop

Wi

General Sub-tab

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 100.

- For descriptions of available settings for the connection type of XenApp, please refer
to “Settings for the Connection Type of XenApp” on page 105.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 108.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

This table only provides descriptions for available settings when XenDesktop is
selected.

Four connection types are available:

Option Description

Provides application, desktop, and content
Web Logon access services through the interface of a
Web browser (Internet Explorer).

XenDesktop Provides desktop delivery services.

XenApp Provides application delivery services.

Provides full server access services for

Server Connection administrators (XenApp servers only).

Sever Address

Type in the IP address / FQDN of the server through which XenDesktop
is accessible.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group

Type in the desktop group.

NOTE: You can use the Search icon ,'L-' in front of the field to discover available
desktop groups. For detailed instructions, please refer to “Connection
Type: XenDesktop” on page 87.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Window Settings
Item Description

Requested Color Quality

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: No preference, Better Speed (16-bit),
and Better Appearance (32-bit).

Option Description

No preference No preference for a specific color quality.

The 16-bit color quality is used for better

Better Speed (16-bit) display speed

The 32-bit color quality is used for better

Better Appearance (32-bit) desktop appearance.

Window Size

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Eight options are available: Default, Seamless, Full Screen,
640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, and 1600 x 1200.

NOTE: When the XenDesktop toolbar is enabled on the server side, you may not
be able to change the window size.

NOTE: For more information about how to disable the XenDesktop toolbar,
please visit Citrix websites at support.citrix.com or www.citrix.com for
online help.

NOTE: In case that you don’t want to disable the toolbar, you can use the
toolbar or your mouse to resize the launched window if needed.
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Device Mapping

Item

Description

Mapping Local Drive

Click the drop-down menu to enable/disable the mapping of the local drive(s) in a
Citrix ICA session. If Yes is selected, the locally attached drive(s) will become available in
launched Citrix ICA sessions.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

Mapping local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

Connection Settings

Item

Description

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Audio Quality

Click the drop-down menu to disable audio playback or choose the desired sound
quality in a Citrix ICA session.

Click the drop-down menu to disable audio playback or to configure the quality
setting for audio playback in a Citrix ICA session. Four options are available:
High - high definition audio, Medium - optimized for speech, Low - for
low-speed connections, and Off.

Option Description

Allows endpoint devices to play a sound
file at its native data transfer rate. This

High - high definition audio is recommended for connections where
bandwidth is plentiful and sound quality is
important.

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium - optimized for speech

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low - for low-speed connections  of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Disables audio playback in opened ICA

Off h
sessions.

Encryption

Click the drop-down menu to select the desired encryption method. Five options
are available: Basic, RC5 128 bit (login only), RC5 40 bit, RC5 56 bit,
RC5 128 bit.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local desktop, On the remote desktop,
In full screen desktops only.




Configuring Client Settings
Configuring Service Access Settings

Settings for the Connection Type of XenApp

NOTE

Wi

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 100.

« For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 102.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 108.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when XenApp is
selected.

Four connection types are available:

Option Description
Provides application, desktop, and content
Web Logon access services through the interface of a
Connection Type Web browser (Internet Explorer).
XenDesktop Provides desktop delivery services.
XenApp Provides application delivery services.

Provides full server access services for

Server Connection administrators (XenApp servers only).

Sever Address Type in the IP address / FQDN of the server through which XenApp is accessible.
Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.

Type in the domain of the server.

Domain NOTE: Type in the full computer/server name if your XenApp server doesn’t
belong to any domain.

Type in the application name.

Application Name NOTE: You can use the Search icon ,'L-' in front of the field to discover available
applications. For detailed instructions, please refer to “Connection Type:
XenApp” on page 89.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Window Settings
Item Description

Requested Color Quality

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: No preference, Better Speed (16-bit),
and Better Appearance (32-bit).

Option Description

No preference No preference for a specific color quality.

The 16-bit color quality is used for better

Better Speed (16-bit) display speed

The 32-bit color quality is used for better

Better Appearance (32-bit) desktop appearance.

Window Size

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Eight options are available: Default, Seamless, Full Screen,
640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, and 1600 x 1200.

Device Mapping

Item

Description

Mapping Local Drive

Click the drop-down menu to enable/disable the mapping of the local drive(s) in a
Citrix ICA session. If Yes is selected, the locally attached drive(s) will become available in
launched Citrix ICA sessions through this connection.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.
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Mapping local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions through this connection.

Connection Settings

Item

Description

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Audio Quality

Click the drop-down menu to disable audio playback or choose the desired sound
quality in a Citrix ICA session.

Click the drop-down menu to disable audio playback or to configure the quality
setting for audio playback in a Citrix ICA session. Four options are available:
High - high definition audio, Medium - optimized for speech, Low - for
low-speed connections, and Off.

Option Description

Allows endpoint devices to play a sound
file at its native data transfer rate. This

High - high definition audio is recommended for connections where
bandwidth is plentiful and sound quality is
important.

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium - optimized for speech

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low - for low-speed connections of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Disables audio playback in opened ICA

Off )
sessions.

Encryption

Click the drop-down menu to select the desired encryption method. Five options
are available: Basic, RC5 128 bit (login only), RC5 40 bit, RC5 56 bit,
RC5 128 bit.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local desktop, On the remote desktop,
In full screen desktops only.
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Settings for the Connection Type of Server Connection

NOTE

Wi

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 100.

« For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 102.

- For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 105.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when
Server Connection is selected.

Four connection types are available:

Option Description
Provides application, desktop, and content
Web Logon access services through the interface of a
Connection Type Web browser (Internet Explorer).
XenDesktop Provides desktop delivery services.
XenApp Provides application delivery services.

Provides full server access services for

Server Connection administrators (XenApp servers only).

Type in the IP address / URL / FQDN of the XenApp server.

Sever Address NOTE: Server Connection only supports connections to XenApp servers.

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.

Type in the domain of the server.

Domain NOTE: Type in the full computer/server name if the server doesn’t belong to any
domain.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Window Settings
Item Description

Requested Color Quality

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: No preference, Better Speed (16-bit),
and Better Appearance (32-bit).

Option Description

No preference No preference in a specific color quality.

The 16-bit color quality is used for better

Better Speed (16-bit) display speed

The 32-bit color quality is used for better

Better Appearance (32-bit) desktop appearance.

Window Size

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Eight options are available: Default, Seamless, Full Screen,
640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, and 1600 x 1200.

Device Mapping

Item

Description

Mapping Local Drive

Click the drop-down menu to enable/disable the mapping of the local drive(s) in a
Citrix ICA session. If Yes is selected, the locally attached drive(s) will become available in
launched Citrix ICA sessions through this connection.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.
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Mapping local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions through this connection.

Connection Settings

Item

Description

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Audio Quality

Click the drop-down menu to disable audio playback or choose the desired sound
quality in a Citrix ICA session.

Click the drop-down menu to disable audio playback or to configure the quality
setting for audio playback in a Citrix ICA session. Four options are available:
High - high definition audio, Medium - optimized for speech, Low - for
low-speed connections, and Off.

Option Description

Allows endpoint devices to play a sound
file at its native data transfer rate. This

High - high definition audio is recommended for connections where
bandwidth is plentiful and sound quality is
important.

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium - optimized for speech

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low - for low-speed connections of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Disables audio playback in opened ICA

Off )
sessions.

Encryption

Click the drop-down menu to select the desired encryption method. Five options
are available: Basic, RC5 128 bit (login only), RC5 40 bit, RC5 56 bit,
RC5 128 bit.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local desktop, On the remote desktop,
In full screen desktops only.
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4,59 Configuring Basic VMware View Connection Settings

The VMware View setting enables you to configure View connection settings for VMware View or Horizon View
desktop services and create shortcuts on the desktop and Start menu for service access. You can access on-demand
desktop services for work simply through these shortcuts.

:%J NOTE

+ For more information on VMware desktop virtualization solutions, please visit
VMware website at www.vmware.com.

%J’ NOTE

+ You can also access VMware View or Horizon View services through the standard
desktop shortcut VMware Horizon View Client. For detailed instructions on how to
access services via the standard desktop shortcut, please refer to chapter 3 “Getting
Started” on page 17 or the Quick Start Guide for t68WD.

+ The following sections will guide you through the steps of creating your own service
access shortcuts on the desktop.

To quickly configure VMware View connection settings, please do the following:

1. On Atrust Client Setup, click Applications > VMware View.

2. The View Connection list appears in the Configuration area.

Atrust Applications | User Interface | Devices | System

” + Add = Delete
~ Session Name Server Address

* Remote Desktop
¢ Citrix ICA

~ VMware View

» Web Browser

Ly
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@‘/ NOTE

« If you haven't create any entry, the View Connection list will be empty.

3. Click Add on the top of the View Connection list to add a new entry of View connection.

Atrust Applications | User Interface | Devices | System
Navigat - =
General Application

' Remote Desktop

» Citrix ICA — Server Settings

¥ VMware View N -
Session Name: | |h

» Web Browser N
Cennection Server : | |h
Port: [ &
& Mluse secure connection (55L)
Certificate checking mode: ‘Wam before connecting to untrusted servers ;

— Login Settings
& Ovog in as current user
User Name: | |;
Password: | |;
Domain Name: [ &
Desktop Name: [ 4
Display Protacol: [Manual M
— Common Settings

Autostart When Startup: ‘ No EI;
On Application Exit: [De Nothing vle
save || cancel

4. Type in the desired session name, and then click Save to confirm.

@ NOTE

« This is the only required field for the creation of a service access shortcut on the
desktop. Other data can be provided during the period of service access. Depending
on your needs, you might choose to type in more other data.

5. The new entry is added to the View Connection list and the access shortcut is created automatically
on the desktop.
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4.5.10 Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Double click the created (customized) access shortcut on the desktop.

2. A window appears allowing you to add the name or IP address of the View Connection Server.

3. Double-click Add Server icon or click New Server in the top-left corner.

+ Mews Server | || e sener

—rt

Add Server

Add Server

4. A window appears prompting for the name or IP address of the View Connection Server. Enter the required
information, and then click Connect.

&

vmware Horizon

Enter the name of the Connection Server.

Connect

5. A window may appear with a certificate message about the remote server. Consult your IT administrator for
details and ensure the connection is secure first. To bypass, click Continue.

VMware Horizon Client cannot verify the identity of the server you
have contacted. Your credentials will not be secure. Contact your
administrator to ask if this server can be trusted.

Continue | | Cancel |

6. A window may appear with a Welcome message. Click OK to continue.
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7. Provide your user name and password on the opened window, and then click Login.

=

vmware Horizon

|£h-i.=ha&:ﬁv'u'CS.VH'J.poc

|\.|’H'.I'

8. A window appears with available desktops or applications for your credentials. Double-click to select the

desired desktop or application.

w o e-

Adobe Reader XI LINE

AN
AN
Snipping Tool Windows Media
Player

9. The desktop or application will be displayed on the screen.

Mozilla Firefox
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4.5.11 Configuring Advanced View Connection Settings

The table below provides a description of each setting item for View connections. Please refer to this table to
configure advanced settings and customize shortcuts on the desktop and Start menu for service access.

General Sub-tab

Server Settings

Item

Description

Session Name

Type in the name for VMware View or Horizon View sessions.

Connection Server

Type in the computer name or IP address of the View Connection Server.

NOTE: For more information on View Connection Sever, please visit VMware
website at www.vmware.com.

Port

Type in the port number used to communicate with the View Connection Server.
To use the default value, simply leave it blank.

Use secure connection (SSL)

Check/Uncheck to enable/disable secure connection.

Certificate checking mode

Click to select whether to verify the identity of the remote server and whether
to connect to an untrusted server. Three options are available: Do not verify
server identity certificates, Warn before connecting to untrusted
servers, and Never connect to untrusted servers.

Option Description
Do not verify server Do not verify the identity of the remote server
identity certificates and connect to it anyway.

Warn before connecting to  Warns and allows users to choose whether to
untrusted servers connect or not.

Never connect to

Disallows untrusted connections.
untrusted servers

Login Settings

Item

Description

Log in as current user

Check to log in to VMware View or Horizon View services with the current user
credentials. When checked, the User Name, Password, and Domain Name fields
will be grayed out.

User Name

Type in the user name for authentication.

Password

Type in the password for authentication.

Domain Name

Type in the domain name of the View Connection Sever.

Desktop Name

Type in the desktop name. Or, leave it blank for users to select one.

NOTE: If Manual is selected for the Display Protocol field below, this field will be
grayed out.
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Display Protocol

Click the drop-down menu to select the display protocol. Three options are
available: Manual, Microsoft RDP, and PCoIP.

Option

Description

Manual

Manually select the desired display protocol.

Microsoft RDP

Use Microsoft RDP as the display protocol.

PCoIP

Use VMware PColIP as the display protocol.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a VMware View or Horizon View session automatically or
not when Windows Embedded starts.

If Yes is selected, when you log in to the system, the VMware View or Horizon
View session will be opened automatically.

On Application Exit

Select what to do when a VMware View or Horizon View session is ended.
Four options are available: Do Nothing, Restart Application, Reboot, and

Shutdown.
Option Description
Do Nothing Returns to the Windows Embedded desktop.

Restart Application Opens a View or Horizon View session again.

Reboot

Restarts your thin client.

Shutdown

Turns off your thin client.

Application Sub-tab

Window Settings

Item Description
Click the drop-down menu to select the desired display size of a View desktop.
Five options are available: Full Screen, Multi Monitor, Large Window,
and Small Window.
Option Description
Display Full Screen Opens the selected View desktop in full screen.
Multi Monitor Opens the selected View desktop in multiple displays.

Large Window

Opens the selected View desktop in a large window.

Small Window

Opens the selected View desktop in a small window.
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4.5.12 Configuring Web Browser Settings

The Web Browser setting item allows you to configure browser session settings and create shortcuts on the
desktop or Start menu for browser sessions.

Configuring General Browser Session Settings
To configure general browser session settings, please do the following:

1. On Atrust Client Setup, click Applications > Web Browser > Global Setting.

Atrust Applications | User Interface | Devices | System
* Remote Desktop
» Citrix ICA — Basic Settings
N HwakYlew Home Page: [hitp:/fwwew atrusteorp.com/ B
~ Web Browser
Global Setting — Proxy Settings

& Ouse a proxy server for your
LAN

— Automatic Configuration

& Oautomatically detect settings
B [use automatic configuration

script

[Lsae |[ concer |

2. Refer to the table below to set up home page, proxy, and automatic configuration settings, and then click
Save to apply.

Basic Settings

Item Description

Home Page Type in the URL of a Web page for quick access via the Home button.

Proxy Settings

Item Description

Use a proxy server for your LAN | Check to use a proxy server in your local area network.

HTTP Proxy Server Type in the IP address of the proxy server.

HTTP Proxy Port Type in the communication port of the proxy server.

No Proxy For Type in the IP address(es) to bypass the proxy server.
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Automatic Configuration

Item Description

Automatically detect settings Check to automatically detect browser settings.

Use automatic configuration Check to allow automatic configuration and indicate the IP address where a
script configuration file is located.

Address Type in the IP address when Use automatic configuration script is selected.

Configuring Specific Browser Session Settings

To configure specific browser session settings and create shortcuts on the desktop and Start menu, please do
the following:

TIP
@
+ You can use this feature to create a desktop shortcut for a specific web page, for
example, your intranet home page.

1. On Atrust Client Setup, click Applications > Web Browser.

2. The Browser Session list appears in the Configuration area.

l\l:I'LISI: Applications | User Interface Devices System
» + Add = Delete
~ Sassion Name

» Remote Desktop
b Citrix ICA

» VMware View

~ Web Browser

Global Setting

o

5’/ NOTE

- If you haven't create any entry, the Browser Session list will be empty.
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3. Click Add on the top of the Browser Session list.

4. On General sub-tab, type in the desired session name, the URL of the initial web page, and select other
settings if needed (refer to the table below for descriptions).

Atrust Applications | User Interface | Devices | System
* Remote Desktop
» Citrix ICA — Basic Settings
’ i -
VMware View Session Name: Xl |L
~ Web Browser | | -
Initial P. :
Global Setting nial Fage =
— Common Settings
Autostart When Startup: [No Me
On Application Exit: ‘ Do Nothing &
save || cancel
Common Settings
Item Description

Autostart When Startup

Embedded starts.

session will be opened automatically.

Select whether to open a browser session automatically or not when Windows

If Yes is selected, every time when you log in to the system, the browser

On Application Exit

Select what to do when a browser session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing

Returns to the Windows Embedded desktop.

Restart Application

Opens a browser session again.

Reboot

Restarts your thin client.

Shutdown

Turns off your thin client.

5. Click Save to confirm. The access shortcut will be created automatically on the desktop.
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Appendices

This chapter provides instructions for the maintenance of your t68WD thin clients.

A.1 Resetting Your t68WD

How to reset your t68WD to the unmanaged state and its settings 123
under Atrust Client Setup to factory defaults

A.2 Restoring Your Operating System
How to restore the operating system for your t68WD 124
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A.1 Resetting Your t68WD

Reset Mode enables you to restore settings under Atrust Client Setup to the factory defaults. Additionally, it also
releases a managed t68WD from the management of Atrust Device Manager, a management console developed by
Atrust for remote and mass client management.

You can perform Reset Mode locally through Atrust Thin Client Menu.

NOTE

+ You can also release a managed t68WD remotely from Atrust Device Manager.
For details, please refer to the User’s Manual for Atrust Device Manager.

o)

To reset your t68WD, please do the following:

1. Restart your t68WD.
2. During the POST (Power-On Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

Atrust Thin Client Menu

Normal boot
Reset Mode

Firmware Update
Reboot

Shutdown

—)) NOTE
— - Five options are available on Atrust Thin Client Menu: Normal boot, Reset Mode,
Firmware Update, Reboot, and Shutdown. See the table below for the

description of each option:

wl

Menu Option Description

Normal boot Powers up your t68WD as the normal startup procedure.

Resets Atrust Client Setup settings and remote management

it status for your t68WD.

Firmware Update Updates firmware for your t68WD through the network.
Reboot Restarts your t68WD.
Shutdown Powers off your t68WD.

3. Use arrow keys to select Reset Mode, and then press Enter to continue.
4. A message appears prompting you for confirmation. Type y to confirm.

5. Upon completion, press Enter to restart.



124

A.2 Restoring Your Operating System

The Recovery DVD for Atrust t68WD enables you to restore your operating system to the factory default state.

NOTE

[l

- Contact our technical support via fae@atrustcorp.com to get instructions on how
to get or make a Recovery DVD.

+ You can also restore your operating system in a similar way here with a Recovery
USB flash drive. Contract our technical support via fac@atrustcorp.com to get
instructions on how to make a Recovery USB flash drive with the help of Atrust
Recovery USB Disk Creator, a tool developed by Atrust.

To restore your operating system through the Recovery DVD, please do the following:

oA W

o

@ WARNING

+ Restoring your system will overwrite all of the data in your system. Ensure that
you've backed up important data before proceeding.

Attach a DVD drive to Atrust t68WD.

Insert the Recovery DVD.

Reboot your Atrust t68WD.

During the POST (Power-On Self-Test) period, press F7 to enter the Boot Device menu.

On the Boot Device menu, select to boot from the optical disc drive (the optical disc drive entry that
starts with UEFI), and then press Enter to continue.

The Atrust Recovery System screen appears.
Press Enter to continue.

A screen appears prompting you to select the source of recovery.
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Atrust Thin Client Recovery System

Valid device: /dev/sr0
CD-ROM mount successfully: device= /dev/sr0

Please choose one source:

CD/DVD

9. Select CD/DVD and then click Next to continue.
10. Select INSTALL or UPDATE, and then click Next to continue.

11. A screen appears prompting your to select the language of the user interface for your Atrust t68WD. Select
the desired language, and then press Next to continue.

%J’ NOTE

+ The available Ul languages may vary with the firmware version of your t68WD.

12. The system recovery starts.

13. After completion, remove the Recovery DVD and then click Finish to restart your system.
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Specifications

Atrust t68WD thin client

Specifications

Processor

Intel® Celeron® N2807, Dual-core, 1.58 GHz

Random Access Memory

2 GB (up to 4 GB)

Flash Memory

mSATA DOM 8 GB (up to 64 GB)

Resolutions Up to 1920 x 1200
I/O interfaces Front: Rear:
2xUSB2.0 1 x Microphone 1xUSB2.0 1xDVI- 1xDCIN
1x Headphone 1xUSB 3.0 1 x DisplayPort 1xRJ-45
Networking 1x10/100/1000Mb Ethernet
Power Input/Output: 100-240Vac, 0.5A, 50-60Hz / DC +5Vdc, 3A

Operating system

Windows Embedded 8 Standard

Supported Protocols

Microsoft RDP with RemoteFX / Citrix ICA with HDX / VMware PColP

Management Atrust Client Setup / Atrust Device Manager

Secu rity 1 x Kensington lock slot

Mount VESA mount kit, (W)114 x (H)6 x (D)60 mm (optional)
Dimensions (W)135 x (H)29 x (D)93 mm

Weight 278 g (approx.), excluding AC adaptor

Environment

Operating Temperature: 0°C~35°C
Non-operating Temperature: -30°C~60°C
Operating Humidity (Rh): 10% ~ 90% (non-condensing)

Non-operating Humidity (Rh): 5% ~ 95%
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